Asylum Research Scanning Probe Microscope Software

User Guide

Version 13, Revision: 1560
Dated 08/25/2013, 16:40:03 in timezone GMT -0700

Asylum Research
an Oxford Instruments company
# Contents

## I  Data and Image Analysis

1. Introductory Image Analysis ........................................... 4
2. Force Curve Analysis .................................................. 59
3. ARgyle 3D Data Visualization ...................................... 98

## II  Programming ......................................................... 120

4. Basic Programming Tutorial ....................................... 122
Introduction

Volumes of the AR SPM Software User Guide

The Asylum Research Software manual comes in volumes. To date these volumes are:

Part I Data and Image Analysis. Once the data are collected, this part of the user guide describes many of the powerful analysis capabilities of the AR software. There are subsections on images and force plots.

Part II Programming. The AR software can be customized for your needs on many levels, from custom control panels to simple macros to completely open source code for all the Igor Pro based code, which defines nearly all the AR software functionality.

AR Software version It is assumed that AR Software version 14 or later is installed on your system.

Getting Help There are many ways to get help with your Asylum Research instrument:

- Go to support.asylumresearch.com. Here you will find FAQ articles, software downloads, manual downloads, and a user forum which puts you in touch with thousands of other Asylum users.
- E-mail us at Support@AsylumResearch.com
- Call us at +1-805-696-6466. Within the US you can call our toll free number (1-888-472-2795). During US west coast business hours you will get a human being to speak with. If you are outside the US timezones, call your local Asylum office or distributor.
- If necessary, we can initiate a remote session and have one of our scientists operate your AFM over the internet.

Updates to the Manual Bundled with the software updates.

Prerequisites

We recommend that you have a running AFM, or at least a functioning copy of the AR software installed on your computer. For an overview of a properly set up MFP-3D AFM, please refer to1. Likewise, for the Cypher AFM a properly operating AFM system includes a PC with the AR software installed. In case this software requires an upgrade, or you want to install a copy on another computer (handy for image analysis), please see https://support.asylumresearch.com/forum/content.php?150-Copies-of-Igor-instructions

1??
Part I

Data and Image Analysis

**Part I: Who is it for?** Once the data are collected, this volume describes many of the powerful analysis capabilities of the AR software. Often useful with a second copy of the software on a computer not attached to the AFM itself.
Part Contents

1 Introductory Image Analysis ................................................. 4
  1.1 Opening Stored Images ................................................. 5
  1.2 The Modify Panel .................................................... 13
  1.3 The Analyze Panel ................................................... 36
  1.4 Miscellaneous Operations ........................................... 51

2 Force Curve Analysis ...................................................... 59
  2.1 Opening Stored Force Plots ............................................. 60
  2.2 Display tab ......................................................... 61
  2.3 Pref tab ............................................................. 66
  2.4 Parm tab ............................................................. 69
  2.5 Cursor tab .......................................................... 71
  2.6 Modify tab .......................................................... 73
  2.7 WLC Tab .............................................................. 75
  2.8 Analyze tab ........................................................ 78
  2.9 Spot Tab ............................................................. 83
  2.10 Elastic tab ........................................................... 84

3 ARgyle 3D Data Visualization ............................................ 98
  3.1 Viewing Saved Images in 3D .......................................... 98
  3.2 Overlaying Data on a Surface ........................................ 99
  3.3 Display Settings .................................................... 105
  3.4 Exporting Images ................................................... 115
  3.5 Activating Real Time ARgyle™ ..................................... 116
  3.6 Advanced Command Line Control .................................. 117
  3.7 Argyle Lite Windows App ........................................... 117
1. Introductory Image Analysis

Chapter Contents

1. Opening Stored Images ................................................................. 5
   1.1 The Browse Graph .............................................................. 7
   1.1.1 The Browse Graph ....................................................... 7
   1.1.2 The List Panel ............................................................. 8
   1.1.3 The Display Window ..................................................... 9
       1.1.3.1 Reprogramming Shortcut buttons .............................. 12
   1.1.4 AR Thumbnail Viewer .................................................. 13

1.2 The Modify Panel ................................................................. 13
   1.2.1 Flatten tab ............................................................... 14
       1.2.1.1 Flatten Example, features on flat substrate ................. 14
       1.2.1.2 Flatten and Planefit Example, Lattice steps .............. 17
   1.2.2 Planefit tab ............................................................. 21
       1.2.2.1 Planefit Example ............................................... 22
   1.2.3 Erase tab ................................................................. 24
   1.2.4 Mask tab ................................................................. 26
       1.2.4.1 Mask Calculation Methods ..................................... 27
       1.2.4.2 Hand drawing masks .......................................... 28
       1.2.4.3 Copying Masks .................................................. 29
   1.2.5 Filter tab ................................................................. 30
   1.2.6 FFT tab .................................................. 31
   1.2.7 History tab .............................................................. 34
       1.2.7.1 How to apply one process to another image: ............... 34
       1.2.7.2 How to apply one process to many images: ............... 35
       1.2.7.3 How to remove one step from a multi step process: ...... 35
   1.2.8 Prefs tab ................................................................. 35
       1.2.8.1 Modify Insert Layers ......................................... 35
       1.2.8.2 Undo Only Last Planefit ..................................... 36

1.3 The Analyze Panel .............................................................. 36
   1.3.1 Roughness Tab .......................................................... 37
   1.3.2 Section Tab ............................................................. 38
       1.3.2.1 Straight Line Sections: ................................... 39
       1.3.2.2 Free Hand Lines ................................................. 41
   1.3.3 Histogram tab .......................................................... 42
       1.3.3.1 Fitting ............................................................. 43
       1.3.3.2 Data Modification .............................................. 43
       1.3.3.3 Other Options .................................................. 44
   1.3.4 Particle Tab ............................................................ 44
This section discusses how to perform basic image analysis on stored image (.ibw) files. Keep in mind that there are not necessarily hard and fast rules or sequences regarding image processing. It can be a trial and error process that depends heavily on the data. For this reason, the processing techniques are broken into sections below, with some examples provided.

1.1. Opening Stored Images

Prepare the software

1. Launch the AR SPM software and you will see the Mode Master window.
   - Click the ‘Mode Master’ button at the bottom of the screen any time you want to load the Mode Master.
   - Click on the ‘Standard...’ tile.
   - Then click Offline Image.

2. Open the image browser:
   - From the menu bar select AFM Analysis → Browse Saved Data.
Select a directory of images:

- If image data is not already loaded in the experiment, it will now ask you where you would like to load data from. If there is data already in the experiment, the Browse Graph will be opened, showing those images. To open a new folder, you can click on the ‘Change Directory’ button in the upper left corner of the Browse Graph (Figure 1.1 on page 7).

- From the load path dialog, you can click the ‘Browse’ button to select a new directory.
  - OR-
  - Use the pull-down menus to visit standard or recently visited directories.
  - Click on ‘That's it’ to load the directory.
  - The Browse graph will open (Figure 1.1 on page 7) as will the List Panel (Figure 1.2 on page 8).

To open an image

- Just double click on the thumbnail to open the full sized image.
1.1.1. The Browse Graph

![Image of the Browse Graph]

**Figure 1.1.** The Browse Graph displays the data as thumbnails. This window can be re-sized by clicking and dragging the corner.

The number labels in **Figure 1.1 on page 7** refer to:

1. **Image Data Type** Specific data channels (i.e., Height, Phase, etc.) can be selected in the *Image Data Type*. This is convenient if a specific image in a folder containing many images includes a data type that most of the other images do not have. For example, choosing NapPhase could help locate an MFM image among many non-NAP images.

2. **Which Image** The *Which Image* pull-down menu determines whether Trace or Retrace data is displayed; selecting *Either* allows both types of data to be displayed.

3. **Vertical/Horizontal Number** Thumbnail display array sizes can be altered by changing the *Vertical* and *Horizontal* values. *Vertical* determines the number of rows in a window while *Horizontal* determines the number of columns.

4. **NextPage** This button advances the screen to the next page of thumbnails, much like using the Igor scroll bar on the right side of Browse Graph. The ‘Page Up’ and ‘Page Down’ commands are keyboard shortcuts for this function.

5. **Copy to Layout** The ‘Layout’ button will take a snapshot of the Browse Graph and dump it into an MFP-3D layout window. See Section 1.4.4 on page 57.

6. **Show Force Data** This pull-down menu is useful for showing the different data types within a directory of force-distance curves.
1.1.2. The List Panel

Images can also be opened in the List Panel (Figure 1.2 on page 8). It consists of two columns: Images on Disk, which are the files stored in the folder, and Images in Memory, which displays the images that have already been opened in the experiment.

- To open an image file, double click on the file name.
- To open multiple images, hold the ‘shift’ or ‘ctrl’ key while selecting images, then click the ‘Open Files’ button.
- Most of the function buttons are self-explanatory, so only a few will be discussed:

  Refresh List  This updates the list of images in the currently selected directory. This is used if images are being acquired real time while stored images are subsequently being processed and analyzed.

  Change Directory  This is the same as selecting ‘Change Directory’ from the Browse Graph. See Section 1.1 on page 5. It allows you to change the data file directory which is displayed in the list.

  Save to Disk  Select one or more images to be saved over the original.

  Note  Processed image layers are typically added to the original as new layers. Your raw data tabs will be preserved.
1.1.3. The Display Window

When an image is loaded from the hard drive, it is displayed in the *Display Window*.

![Display Window Image](image)

**Figure 1.3.** The Main Image Display Panel

Figure 1.3 on page 9 shows an example of a Display Window image that will be used throughout this section. Some of the controls at the top of this window are as follows:

1. **Range** This adjusts the color scale, thereby changing the contrast.
2. **Offset** This adjusts brightness by changing where the center of the color range is.
3. **Color Bar** This checkbox allows the color scale to be viewed or to be removed from the image.
4. **Auto button** This auto-scales the color scale and offset.
5. **ColorMap** This pull-down menu offers many color tables to display the image data with.
6. **Stored data channel tabs** The measured data channels – such as amplitude, phase, height, and Zsensor – collected during a sample scan are saved as layers of the image. The tabs bring an image layer to the front for viewing.

   a) **Tab Naming Conventions:**
      
      i. Raw Data Raw Data tabs typically have three-letter names. The first two letters refer to the data channel, such as Ht (Height), Am (Amplitude), Ph (Phase), and ZS (Z Sensor). These two letters are then followed by the letter T for trace or R for retrace. HtT would be the height trace signal, HtR the height retrace signal. The number of tabs present in an image depends on what channels were saved when the data was collected.
ii. Modified Data Modified or processed image layers include an asterisk in their name and are located to the right of the raw data tabs. Since it is possible to have multiple modified layers of one original raw layer there is a number included in the layer name. For example, the first modified layer of HtT would be HtT*0. Please see Section 1.2.8 on page 35 for more on this subject.

7. Command Functions The Commands pull-down menu (Figure 1.3 on page 9) offers a large variety of functions, most of which are described below. Some of the more frequently used functions are repeated as programmable buttons to the right of the Commands pull-down menu. The default buttons are shown in the margin next to the relevant command.

Display Panel This opens a window called the Display Manager, which includes a list of all the image display windows open at the moment. It allows you to bring any window to the front and to close, tile, or stack selected windows.

Modify Panel Functions such as flattening, planefitting, masking, and filtering are performed via the Modify panel. See Section 1.2 on page 13.

Analyze Panel This is where roughness measurements, line sections, histograms of image data, and particles are created, displayed, and generated. See Section 1.3 on page 36 for a more in-depth discussion.

List Panel This panel allows the user to open images, change directories, save images, and rename extracted images. See Section 1.1.2 on page 8.

Extract Layer This function can export a copy of an individual image channel to facilitate custom processing. See Section 1.4.2.1 on page 51.

Insert Layer This function reinserts an extracted layer into the display window. See Section 1.4.2.4 on page 55 for examples.

Delete Layer This command deletes the current image layer.

Show Note This is where many parameters associated with the image can be viewed.

Image Name–Show This button, which toggles between Show and Hide, changes whether the image name is shown within the Display Window. It can be useful for graphic exporting.

Change User Names This lets you change the names of images stored as data from the BNC connectors on the front of the controller. UserIn0 can become something more descriptive, such as Photocurrent.

Save Image This will save any modifications to the display window, such as modified data or inserted layers in new tabs. See Section 1.4.1 on page 51 for more details.

Save As... After requesting a new name for the selected image, this function will save the image to a location specified by the user.

Save then Kill Image This saves the image, including all associated layers and tabs, then closes the window.

Kill Image This will remove the image from memory.

Export to Layout This is a feature that appends the current image to a notebook style page. This process is described in Section 1.4.4 on page 57.
**Tiff exports:** Tiff exports the current layer to a directory of choice as a separate image. It includes numbers indicating the resolution of the new file it will have (1, 2, or 4 times the number of pixels as the original image). These files can get very large, but are great for graphics that need to be displayed at larger scales, such as on posters. Note that you can also choose *Edit > Export Graphics* from the main menu. This gives other sizes and file formats as export options.

**Set Layout Fields** This brings up a list of display parameters for the ‘Export to Layout’ function.

**NanoIndenter Tip Area Function** This brings up a graph that will calculate Tip area from Z sensor images of either nanoindenter tips or indentation. These tip area graphs can be used in the analysis of indentation force plots on the Elastic Tab of the force review software.

**Crop Image** Once zoomed in on an image, this command will discard all data outside the current viewing area. This is done to all layers of the image. Please follow the steps in Section 1.4.3 on page 56, as they include a protocol which will prevent the permanent loss of raw data.

**Help** This links to more detailed descriptions of these items.

**New Appearance** This toggles between the new and classical appearances of the 2D graphs.

**Argyle 3D** This button launches a 3D view of the data. Detailed in Chapter 3 on page 98.

For Display Windows with many image channel tabs, small arrow buttons to the left of the tabs allow the user to move left or right through the image layers. If there are only a few tabs, these are grayed out and inactive.
1.1.3.1. Reprogramming Shortcut buttons

**Tip** The shortcut buttons in the Display Panel (Section 1.1.3 on page 9) are programmable.

Any function from the *Commands* pull-down menu can be assigned to any of the buttons. For instance, the ‘Note’ button, marked with the letter N, can be replaced with a ‘Crop’ button, labeled with the letter C. Reassign one of the shortcut buttons as follows:

- Ctrl+click on any of the six buttons.
- This will produce the dialog box to the right.
- Select button you want to reprogram.
- Enter a new name for it; up to two letters can be displayed on the buttons. Usually, the name is based on the initials of the function.
- Choose the desired command from the pull-down list.
1.1.4. AR Thumbnail Viewer

On the Windows operating system side of the software, the AR thumbnail viewer is useful for finding a specific image within Windows File Manager. This feature is installed as a Windows extension along with the AR software.

1. Right click on an image file, and choose Properties.

2. A panel similar to Figure 1.4 on page 13 will appear. The Asylum Research tab will have a larger thumbnail of the stored image, and the lower portion of the panel has the pertinent scan parameters.

3. On the pull-down menu you can view any of the data channels, including amplitude, height, and phase.

1.2. The Modify Panel

M stands for the Modification of raw image data. Usually this entails image processing of the individual image layers to enhance features. The modify panel can be opened from:

- The menu item: AFM Analysis ▶ Modify Panel
- The ‘M’ button on any offline image.
- Commands ▶ Modify Panel on any offline image.
1.2.1. Flatten tab

**When to use:** AFM images are subject to line-by-line variations in the height due to thermal drift, scanner artifacts, and various other complications. In order to correct for these differences across the image, a simple flattening correction can be applied to the data. Although the calculations and data transformations involved are relatively simple, the results are highly dependent on the data inputted into the algorithm.

**How to use:** Flattening fits each scan line with a polynomial and subtracts it from the data.

- 0 order is the most commonly applied flatten. This data transformation is widely accepted in the literature. In this calculation, a simple offset is obtained by taking the average of the unmasked region of the scan line, then subtracting the average from the entire scan line.

- 1st order polynomial is also very common; it subtracts a straight line from the data. Care needs to be taken to prevent this modification from altering the actual features of the data; see Section 1.2.1.1 on page 14.

- 2nd order polynomial is much less common. Great care needs to be taken with this modification as it has much more potential to deform the data.

- 3rd order polynomial probably should not be used for any publication. It is included in the software just for tinkering with data.

1.2.1.1. Flatten Example, features on flat substrate

**Overview** For a successful application of flattening with minimal data transformation, flattening should only be performed on portions of the AFM image that represent the background. In this case, we presume the background to be a relatively flat substrate. Non-background features are
excluded from the calculation with a mask, thereby preventing actual features from being used to calculate the fit of the polynomial. The use of masks is discussed in Section 1.2.4 on page 26. Here we will do a standard iterative process that works well for a wide variety of images:

- Flatten 0
- Mask
- Flatten 1

In this particular example we will be using an image of DNA on mica. You can download this image file from here: http://www.AsylumResearch.com/Files/Data/FlatteningExample1.zip

1. Starting image layer:
   - With an image open, select the desired image channel.
   - From the large offsets between lines, you can tell that this image will require at least a flatten 0

2. Click the button to open the Modify Panel.
3. Set the flatten order to 0.

4. Perform the Flatten
   - Click ‘Flatten’. Notice that there are flattening artifacts (black streaks) to the left and right of taller features.

5. Go to the Mask Tab and select Iterative from the Calc Method pull-down menu.
Create the first mask.

- Click ‘Calc Mask’.
- Make sure Fill Mask is still selected in order to show the masked pixels. The red pixels highlighted in this way will subsequently be masked out and ignored.

Erode the mask [optional]:

- Click ‘Erode Mask’ once to eliminate small, undesirable spots that have been masked.
- Notice the mask covers less of the features.

Dilate the mask [optional]:

- Click ‘Dilate Mask’ twice to enlarge the mask.
- Note that eroding and dilating are not always reversible.
- Redo the mask with an iterative mask to restore the image to its state in step 6. This is necessary to continue the example.
Ch. 1. Introductory Image Analysis

Sec. 1.2. The Modify Panel

   - Select the Flatten Tab.
   - Select a flatten order of 1 from the pull-down menu.
   - Click the ‘Flatten’ button.

10. Note
    - This procedure works because it keeps the order to 0 or 1. Sometimes it is useful to go to a second order flatten in order to calculate the mask. Be aware in this case that you must undo the second order flatten between creating the mask and applying a first order flatten to eliminate second order modifications to the data.

11. Review: [optional]
    - Create 3D images of the starting point and the end point.

1.2.1.2. Flatten and PlaneFit Example, Lattice steps

Overview

Sometimes it is useful to use a combination of planeFit and flatten, for example lattice steps can prove to be difficult to correct. It will require an iterative process of masking, and correcting, while trying to minimize the distortion of the data. The use of masks is discussed in Section 1.2.4 on page 26, and the use of planeFit is discussed in more details in 1.2.2. Here the outline will be:

- Manual mask
- PlaneFit X1
• Improve mask
• Planefit X1
• Assess if Flatten 0 is required
• Assess if Flatten 1 is required.

In this particular example we will be using an atomic step of gold, sample courtesy of Nir Kampf of the Weizmann institute. You can download this image file from here: http://www.AsylumResearch.com/Files/Data/FlatteningExample2.zip

1. Starting image layer:
   • With an image open, select the Z sensor channel.

2. Click the button to open the Modify Panel.

3. Hand draw a mask on one side of the image
   • Go to the mask tab, click on include points and then drag a box from 6 to 8 µm in X and spanning the entire Y axis.
   • Click on Make Mask on the mask panel.

4. Go to the planefit tab.
   a) Set the Offset uses to Mask, this will set one level of the lattice to zero, otherwise zero would be between the two levels.
   b) Do a first order planefit in just X.
5. Create a better mask.
   - Go to the Mask tab
   - Set the Calc method to bimodal
   - Click Calc Mask
   -OR-
   - Click in the middle of the histogram to set the level between the 2 peaks.

6. Planefit X 1 again
   - Optional: Do an Ultra restore to undo the previous modifications to the image, including the saved planefit that was done to the image.
   - Back to the planefit tab, and do another first order planefit in XY.
   - Click auto scale (on image)
Do a 0 order flatten [optional]:

- The rest of the instructions in this example are optional, you need to look at your image, and figure out if you need to go further or not.

- This particular image shows some discrete shifts in the slow axis, a couple from 0 to 2 µm, and clear one at about 3.5µm, these will require at least a zero order flatten.

- Make sure that the offset uses is set to mask.

- Try adjusting your mask again, use the histogram, and mask off most of the histogram.

- Look at the other side of the lattice (doing a flatten will make the visible side look good, but could make the other side worse).
  - click on inverse mask on the mask panels.
  - click on auto on the image to adjust the scale.

Mask and flatten 0 again:

- Use the histogram to make a wider mask, to make sure you cover the step, but if you get mask showing up on the far side of the image (e.g. the right side is mostly masked, and the left edge of the image is also masked), then that is going to go badly. Try adjusting your mask more, but you may need to undo flattens to fix the mask.

- Do a 0 order flatten again.

- This should do a good job of getting rid of the offsets between scan lines, but there could still be some slope to the lattice steps.
Mask and Flatten 1:

- Use the histogram to make a wider mask, make it really wide to include nearly all of the histogram, but leave as much of the image unmasked.
- Do a 1st order flatten.
- Look at the other side of the lattice again.
- Take a section across the image.

1.2.2. Planefit tab

When to use: Planefitting is useful when you have sample that is known to be flat, but has a tilt to it. Thermal drift and sample mounting are two common reasons for a straight sample to give a tilted height image. By fitting and subtracting a plane to the entire image, the image can be made flat. Measuring topographical features then becomes easier since there is a relevant zero height from which to measure.

How to use: Plane fitting is very similar to flattening. It fits the unmasked data to find and subtracts a plane of specified order.
• 0-order not very common, as this option simply takes the offset of the unmasked image.
• 1st-order is the most common. It subtracts a flat, sloped plane from the image.
• 2nd-order is much less common. Care needs to be taken with this modification as it has much more potential to alter the topography. In this calculation a second order polynomial plane is subtracted from the image.
• 3rd-order probably should not be used for any publication. It is included in the software just for tinkering with data. In this calculation a third order polynomial plane is subtracted from the image.
• Histogram is a much more complicated algorithm; it is more of a recipe that seems to do a good job on a wide variety of images. It:
  – Does some filtering on a temporary copy of the image.
  – Calculates a mask based on the histogram of the filtered data.
  – Does a 1st-order planefit to the image.

1.2.2.1. Plane fit Example

Overview  In this example we will go through the various plane fit orders and compare their results on a highly curved sample.

We will be using an image of human hair. You can download this image file from here: http://www.AsylumResearch.com/Files/Data/Plane fitExample1.zip

Starting image layer:
• This is the original Z sensor image of a human hair.
2. Do a 0 order planefit:
   - Note that a new layer with an average of 0 was created.

3. Do a 1st order planefit:
   - Since we are increasing the order, we can simply do this on the modified layer.
   - Note that the left edge of the hair is lower than before.

4. Do a 2nd order planefit:
   - Note that the image is drastically different.
   - This can be helpful, in that details on the surface of the hair are clearer, but caution is required as those features could be artifacts from the 2nd order planefit.
5. Do a 3rd order planefit:
   - The 3rd order planefit is similar to the 2nd order planefit, but more extreme.

6. Histogram planefit:
   - You need to first undo the planefit; click ‘Undo Planefit’ or ‘Restore Layer’. Note that the latter option will undo modifications prior to the planefit.
   - Set the order to Histogram and click ‘XY’.
   - Note the similarity to the 1st order planefit. The hair was masked out, so the side of the hair is more planar as a result of this modification.

1.2.3. Erase tab

---

**Figure 1.7.** Erase controls.
When to use: Abnormal scan lines can make adjusting your color scale difficult, can be problematic in masking and can skew some analysis (such as sections). Note that erasing too many lines in publication grade data can work against you; experienced SPM users expect aberrant noise lines in publication images. Please use this feature with discretion. Appropriate use may include the removal of lines caused by disturbances in a lengthy image scan (your lab mates slamming doors while the best image of your life is being collected).

How to use: Select the line or lines that you wish to have blurred out, adjust the width to make sure the lines are covered, and click ‘Do It’. The the marked lines will be replaced with averages of the lines remaining on either side of the block to be erased.

1. With a Display Window image open and the desired image channel as the forward most tab (for example, Height Trace (HtT) in Figure 1.3 on page 9), click the ‘M’ button to open the Modify Panel.

2. Locate the bad line:
   - Identify the offending line. In this case it shows up particularly well in a 3D view of the data.

3. Zoom in:
   - Expand a small area around the lines to be erased.
   - Do this by selecting the area of interest in the image and then right clicking on the area. Select Expand or Vert Expand.

4. Go to the Erase tab of the Modify Panel.
5. Click the ‘Draw Lines’ button.
Select the offending line

- While holding the left mouse button down, place the pointing finger cursor over the scan line you wish to remove, then release.
- Notice the line goes from red while positioning to blue when set.

7. If necessary increase the Line Width value (Figure 1.7 on page 24) to cover more lines.

8. If the placement of the line is unsatisfactory, click the Clear Lines button to remove them. Repeat the attempt.

9. Click the Erase Lines button. The line will disappear from the image, indicating that the erasure has taken place.

10. With the cursor over the image, use Ctrl + A to restore the original zoom and assess the results. It is also possible to zoom out by right clicking and selecting Autoscale Axes.

1.2.4. Mask tab

![Image masking controls.

Figure 1.8.: Image masking controls.]
When to use:  Flattening (Section 1.2.1 on page 14) and Plane Fitting (Section 1.2.2 on page 21) should be applied exclusively to the part of the image that is known to be planar. Image masks allow the non-planar areas to be omitted during the fitting. The mask can also be used for image analysis exclusively inside or outside the mask (see section Section 1.3 on page 36).

How to use:  Masking is used to exclude some portion of the image, typically by setting a threshold value to include the pixels above or below that threshold. There are a couple of ways to make finding the threshold value easier, and a number of other methods to fine tune the resulting mask. The general steps for a simple manual mask:

1. Drag the blue vertical line through the histogram graph to set the threshold for the mask.
2. [Optional] Invert the mask using the ‘Invert’ checkbox.
3. [Optional] Use ‘Range’ to mask a range of values in the middle of the histogram; it is also possible to unmask this range by checking ‘Invert’.

Next, a simple automated method:

1. With a Display Window image open and the desired image channel as the forward most tab (for example, Height Trace (HtT) in Figure 1.3 on page 9), click the ‘M’ button to open the Modify Panel.
2. Go to the Mask tab of the Modify Panel (Figure 1.8 on page 26).
3. Confirm that Iterative is chosen in the Calc Method pull-down menu. This method is a good mask to start with to find the proper threshold value.
4. For typical AFM samples with a flat background and protruding features, check the ‘Inverse’ checkbox. For a sample with pits, do not choose ‘Inverse’.
5. Click the Calc Mask button. A threshold will be determined that may work for your image. Notice that the Calc Method has changed to Manual, and the determined threshold has been entered.
6. If the mask seems close to where you want it, but should encompass a bit more adjacent area, click the ‘Dilate’ button. This will add pixels around the existing perimeter of the mask. Click ‘Erode’ to shrink the masked area. You can also eliminate lots of small masked areas by eroding one or two steps, then dilating back again. Only large blobs will survive that process. For examples of this, see Figure 1.9 on page 28.
7. If the mask seems completely off, you can always edit the threshold and range values and manually recalculate the mask. Alternately, use the histogram to set the threshold manually, as described in the simple manual mask above.

Once you have your mask, flattening and plane fitting will only use the unmasked areas for the fit, but will apply the subtracted fit to the entire image; the unmasked areas are affected, but not used for the fitting.

Filters such as smoothing or blurring will only be applied to the unmasked area. Masked areas will remain exactly as before the filter.

1.2.4.1. Mask Calculation Methods

There are many different mask algorithms to choose from:
Manual The user may enter a value into the Threshold range. This will put the mask above or below that value, depending on the state of the ‘Inverse’ checkbox. There is also a histogram on the mask panel that represents the image data. You can drag a blue vertical line on this histogram to set the threshold graphically.

Iterative This calculation automatically picks a Z threshold range using an iterative method.\(^1\)

Bimodal The mask is calculated based on the assumption that the image histogram is a simple bimodal distribution\(^2\).

Adaptive Adaptive thresholding evaluates the threshold based on the last 8 pixels in alternating rows\(^2\).

Fuzzy Entropy This function uses entropy as the measure for fuzziness\(^2\).

Fuzzy-Mean Gray: Fuzzy thresholding uses a method that minimizes a fuzziness measure involving the mean gray level in the object and background\(^2\).

Typically, one uses manual or iterative. Playing with the more exotic methods is encouraged. They can sometimes surprisingly lead to the result you were looking for.

![Figure 1.9.: Creating image masks: A) after zero order flatten (i.e., no mask); B) after Iterative mask; C) Panel B) after Erode mask button click; D) Panel B) after Dilate Mask button click.](image)

1.2.4.2. Hand drawing masks

When all the automated mask algorithms fail, or if they work except for one area, it is possible to add or subtract areas from the mask by hand. This can be done either to an existing mask or to an unmasked image.

1. To add points to the mask, click ‘Exclude Points’. This will cause a set of drawing tools to pop up to the left of the Image Display window (Figure 1.3 on page 9). The points will be excluded from subsequent operations.

2. Select a tool and draw a shape around the area of the graph you want to add to the mask. You can draw multiple areas with multiple tools during this step.

Advanced Note: Each tool can be right clicked to reveal more tools.

3. Notice that the ‘Exclude Points’ button has turned into ‘Make Mask’. Click that button and the outlined areas will be added to the mask.


\(^2\) This function [ImageThreshold] was designed by Wavemetrics Inc. and is built into the Igor Pro software. Please refer to the Igor Pro Software manuals for more information.
Note: To remove areas from a mask, follow the same steps using the ‘Include Points’ button. They will be included in subsequent image processing.

Figure 1.10.: Using ‘Exclude Points’ masking feature: A) Click on exclude points, and select the free hand tool to make shape; B) Draw the shape on the image C) Change the tool to ellipse and drag around the height feature to also be excluded, blue indicates it can be moved on image with arrow keys; D) Click on Make Mask. Data courtesy of Keith Jones, Asylum Research; sample courtesy J. Schlenoff, FSU Chemistry.

1.2.4.3. Copying Masks

In some instances, performing two separate iterative mask calculations on two separate image channels in a data file can give two different results. This can be problematic, especially when overlaying two channels in ARgyle (Section 3.2 on page 99). In these instances, it can be a good idea to copy the mask from one channel and paste it into the other channel.

Another reason to copy the mask is to save processing time when trial and error approaches are being employed with planefitting or in finding a flattening order.

1. Make a mask on one of the image layers using the methods described above.

2. Click the ‘Copy Mask’ button.
3. Select another image layer.

4. Click the ‘Paste Mask’ button. This will paste the mask on top of whatever mask was already present on that layer.

   a) If you are using multiple clipboards, there will be menu to the right of the ‘Paste Mask’ button allowing you to select which clipboard to use.

### 1.2.5. Filter tab

![Filter tab](image_url)

**Figure 1.11.: Image filtering controls**

**When to use:** Flattening and planefit are very good “filters” for AFM images, they apply a modification to the data, that can remove typically problems in AFM images. But sometimes you need a bit more, the filter tab has more general use filters, that can be applied to any image data. In fact a lot of these algorithms were developed for photography. But if you are having trouble making out edges, and you know not to use that resulting image for quantitative analysis, it is perfectly reasonable to apply a harsh edge finding filter.

**How to use:** This tab applies a variety of standard image processing techniques to the unmasked part of the image (see 1.2.4). The two filter types that are primarily used are the NxN and 3x3 matrix filter. At each pixel of the image, they look at the nearest neighbors of that pixel, and apply an operation on those neighboring pixels to calculate the new pixel. A very simple 3x3 filter would take an average of the 9 pixels, and put that value into the center. A description of these matrix filters can be defined better in the software help menus.
• **NxN filter:** Pull-down; this matrix filter has various filter method types including: Median, Average, Gauss, min, max, NaNZapmedian.

  – **Size:** Defines the size of the NxN matrix; the larger the number, the more the pixel will be blurred (influenced by more neighbors).

  – **Passes:** Defines the number of iterations that filtering process undergoes, also more passes means more blurring, but can sometimes work better than increasing the size.

• **3x3 Filter:** Additional filtering options are listed in this pull-down; filter types here include: surface edges, find edges, point, sharpen, sharpen more, and gradient filters in each direction (N,S,E,W).

Consult any standard image processing textbook to see which filter is best for the type of noise or feature you are trying to suppress or enhance. Also consult the Igor Pro user guides, since most of the image filters are built-in Igor Pro functions.

| Note | To remove spiky noise on surfaces, consider the median filter. Unlike Gaussian filters which tend to blur everything, median filters can remove noise while preserving edges. |

An example of how to apply a 1 pass 3×3 median filter on an image:

1. With a Display Window image open and the desired image channel to modify as the forward most tab (for example, Height Trace (HtT) in Figure 1.3 on page 9), click the M button to open the Modify Panel.

2. Select the Filter tab.

3. Select median from the N×N pull down menu.

4. Set Size to 3 and pass to 1.

5. Click the ‘Do It’ button just below N×N Filter

6. A new tab will appear in your Image Window with the filtered result.

### 1.2.6. FFT tab

**When to use:** FFT filtering can be very handy when trying to reveal an underlying periodic structure in a sea of noise, as well as removing that periodic noise from images. Doing a fast Fourier transform (FFT) on the image gives you a measure of the frequency components of the image. The noise is removed by masking out regions of the FFT, and decreasing their strength. The result and the difference are reported before you confirm putting the iFFT (inverse FFT) back into the original image.

**How to use:**
Select Image, Open Mod

1. With a Display Window image open and a desired image channel to modify as the forward most tab, click the M button to open the Modify Panel.

Select FFT tab and prepare the panel:

2. Select the FFT tab.

- Make sure the the Auto check box is selected. Now change the Image pull down menu and make sure auto is selected for all three values (FFT, iFFT, Diff).
- Click the ‘Make Graph’ button.

Create mask, run the filter:

3. Click the ‘Exclude Points’ button.

- Have the fillmask checked.
- Choose a drawing tool from the pop-up to the left of the window.
- Draw rectangles or ovals around the periodic peaks in the FFT window.
- Click ‘Make Mask’.
- Leave the FFT multiplier at 1.00e-9.
- Click ‘Do It’ and the two square images to the right of the elongated FFT window will refresh with new contents.
**Result:** The window on the upper right was formed by only the spatial frequency components inside the two selected ovals. All the other rejected (masked out) frequency components are shown in the image below that. The lower image looks largely like random noise. There is a tiny bit of structure left in it, perhaps warranting another attempt at drawing the masking ovals a bit larger. But this will do for the purposes of this demonstration, which preserved the majority of the low frequency components and gave the image its long range structure. Comparing to the unfiltered image shows that some of the atomic steps near the center of the image are not truthfully represented in the filtered result.

Re-insert the result into the original image:

4. In the FFT tab (seen in Step 2 above) click the Insert Layer button.
5. Click ‘Do It’ in the next window, and the filtered result is added as a new layer to the original image.
1.2.7. History tab

Figure 1.12.: History Tab.

When to use:  This tab will show what modifications have been done to the current image. This is where various steps and filters that were applied can be undone. In addition, once a series of image processing steps have been performed on one image, they can be copied and applied to a batch of images.

How to use:

1.2.7.1. How to apply one process to another image:

1. With a Display Window image open, click the ‘M’ button if you have not already done so.

2. With an image layer that has some image processing applied to it, click the History tab on the Modify Panel. Here you will see a list of applied filters and processes.

3. With all or some of these processes selected, click the ‘Copy’ button. This will copy the selected steps. A new item will appear under the Set pull-down menu, indicating that the selected history may be applied elsewhere.

4. Select the image and layer you want to apply this process to. Select the appropriate history choice from the Set pull-down menu.

5. Click the ‘Execute’ button and the series of steps will be applied to the new image.

Note  If the process is particularly elaborate, save the current experiment history so it can be used to process future images. If the images have been killed and reopened, the history window will not show what modifications were made. FFTs are not listed in the history.
1.2.7.2. How to apply one process to many images:

1. Do steps 1 through 4 above 1.2.7.1.
2. Check the Global Execute checkbox at the top.
3. Click on the D button to bring up the display manager.
4. Select the images you want to operate on. Note that only displayed images are listed here, you may need to display additional images from the list panel see Section 1.1.2 on page 8.
5. Go Back to the History tab, and click on Execute, and it will apply those steps to all of the images selected in the display manager panel.

1.2.7.3. How to remove one step from a multi step process.

1. Make sure that only the steps you do want to do are selected in the history list.
2. Make sure that Global execute is not selected.
3. Make sure Restore Prior to execute is selected. This will undo all the modifications to the current image first, and then go through the history, applying the selected steps.
4. Make sure set is set to current layer.
5. Click execute.

1.2.8. Prefs tab

![Modify Panel Preferences](image)

**Figure 1.13.:** Modify Panel Preferences

This tab has 2 complicated controls that do not seem to belong in any other section.

1.2.8.1. Modify Insert Layers

This is the checkbox shown in Figure 1.13 on page 35. We already mentioned in Tab Naming Conventions on Step 6a on page 9 that modifying a layer places the result in a new layer with an asterisk in its tab. This new layer creation is the default behavior when ‘Modify Insert Layers’ is checked. If a modified layer already exists for a certain channel, more modifications will overwrite that layer. In other words, filtering a raw data layer automatically creates a scratch copy. Subsequent filtering of that scratch copy will keep overwriting the results of the scratch copy. This preserves your original data while preventing the pileup of countless scratch copies.
**Example:** Your data has Height Trace and Deflection Trace. You apply a flatten to the height layer. With *Modify Insert Layers* not checked, the original height layer would be overwritten. If *Modify Insert Layers* is checked, then you will get a new layer called HtT*0* which has the flattened height data. If you where to then view the HtT*0* layer and do a filter on it. The data in that layer will be overwritten, regardless of the state of this control, with the flattened and filtered height data. Finally, you go back to the original Height Trace layer and do a planefit. The HtT*0* layer will be overwritten with the original height data, followed by the planefit; you lose the flatten and filter.

### 1.2.8.2. *Undo Only Last Planefit*

This checkbox changes how ‘Undo Planefit’ works.

- If it is not checked, everything works the way it used to. When the ‘Undo Planefit’ button is clicked, it undoes all the consecutive planefits applied to the selected image. In addition, when this control is not checked, it is impossible to undo a planefit once another operation, such as a flatten, has been performed. The planefit can only be removed if the layer is restored.

- If it is checked, then clicking on the ‘Undo Planefit’ button will undo only the last planefit. If a first order planefit is applied after a second order planefit has been calculated, only the first order planefit will be removed. When this control is checked, a planefit can be undone at any time, and no other modification will be reversed. The only other way to do this would be to use the History tab; see Section 1.2.7 on page 34. Finally, if this control is checked, then you can undo the RealTime Planefit; this function is completely backward compatible. You can load up old data and undo the RealTime Planefit. There is no other way to reverse the RealTime Planefit.

### 1.3. The Analyze Panel

The Analyze panel is where roughness, line sections, histograms, and particle analysis of image data can be performed.
1.3.1. Roughness Tab

![Roughness Tab Image](image)

**Figure 1.14.** The Roughness tab of the Analyze panel.

*When to use:* This tab provides statistics on images. When used with the mask tab 1.2.4, it can also provide statistics of the unmasked portions of the image. The topmost image will have its statistics displayed. See the gray help buttons for descriptions of statistics. If the image is masked, then the Masked Image column will have the statistics excluding the masked pixels.

*How to use:*

1. With a Display Window image open and the desired image channel as the selected tab (for example, Height Trace HtT in Figure 1.3 on page 9), click the ‘A’ button to open the Analyze Panel.
2. Select the Roughness tab.
3. View statistics of the currently selected channel.
4. Click the ‘Export Roughness’ button to create a text file of the statistics and save it to the directory from which the image originated.

An example of image roughness measurements relative to surface features contained by the mask is shown in Figure 1.15 on page 38. You can download this image from here: [http://www.AsylumResearch.com/Files/Data/RoughnessExample.zip](http://www.AsylumResearch.com/Files/Data/RoughnessExample.zip). Panel (A) shows an image of an elastomeric mold that contains no image mask. Notice the Masked Image column of the Roughness tab shows Nan, “Not a Number,” because there is no mask. Panel B shows the result of an iterative mask with ‘Inverse’ checkbox NOT activated. The values in the Masked Image column represent the areas outside the mask, which include the lighter areas of the image. Finally, in Panel
C), the mask was manually set to include the smaller features of the mold above the plane of its main surface; these statistics represent the image with the ‘Inverse’ checkbox activated.

Figure 1.15: Roughness panel statistics: A) Unmasked image; B) Iterative mask results; C) Manually adjusted to mask smaller features at top of pattern.

1.3.2. Section Tab

Figure 1.16: The Section tab of the Analyze Panel.
When to use: The Section tab allows you to make line sections to extract image data. Both straight lines and curves can be defined. The lower portion of the panel provides measurements along the image section.

How to use:

1.3.2.1. Straight Line Sections:

1. With a Display Window image open and the desired image channel as the selected tab (for example, Height Trace, HtT in Figure 1.3 on page 9), click the ‘A’ button to open the Analyze Panel.
2. Open the Section tab.
3. Make sure Mode is set to Line.
4. Make sure the ‘Angle’ checkbox is unselected.
5. Click the ‘Draw’ button.

Draw a line:
- Click the spot on the image where you want the section to start. Hold the mouse button down.
- Drag to the endpoint of the section and release the mouse button.
- Note the two cursors at the ends of the line section. They can be dragged to other locations in order to reorient the line section.

Optional Select the Full Width checkbox if you want the line section to extend to the edges of the image.

View section:
- Once the line is drawn, a Section plot will appear.
- Drag cursors from the bottom of the trace graph onto the trace; corresponding markers will appear on the image.
- Positions and distances between the cursors are displayed in the lower half of the Analyze panel.

Optional Click the Export Table button on the Section Panel if you want to store the information.
Average over multiple lines:

- Increase the pixel width of the line to average the section over a broader path. The control is located next to the Full Width checkbox.
- The section graph will update automatically.

**Note** The width uses units such as “n” for nanometers or “P” for pixels.

---

**Leveling Line Sections** If an image happens to possess some tilt, as is usually apparent from section data, using the Igor cursors to measure a meaningful height difference is not an easy process. One possibility is to perform a first order XY planefit on the image before making sections, as was discussed in Section 1.2.2 on page 21. An alternate solution based on manual subtraction of a linear background can be executed if the section data are already on screen. The latter is described below.

1. Hold down the ‘Ctrl’ key while moving the mouse pointer over the curve. An up/down arrow cursor will appear.

2. Click and drag vertically to change the underlying slope of the curve. Manually level the background.

**Note** Be sure not to confuse these leveled curves with real, unmodified data. Only the section profiles are altered, and this modification will be undone if the section is updated.

**Adjust the XY Angle of the Section Line on the Image** There are two ways to adjust line section angles with the section drawn:

- Move one of the end cursors on the section line by left clicking and dragging it to a new point.
- Select the ‘Angle’ checkbox, then manually adjust the angle by typing values into the *Angle* field on the Section panel (Figure 1.16 on page 38).
Note: Once the ‘Angle’ checkbox is selected, the section cannot be rotated with the cursors.

1.3.2.2. Free Hand Lines

Free hand lines are curved lines that are drawn by hand.

1. With a Display Window image open and the desired image channel as the forward most tab (for example, Height Trace (HtT) in Figure 1.3 on page 9), click the ‘A’ button to open the Analyze Panel.

2. Open the Section tab.

3. **Set up for drawing:**
   - Select *Free Hand* from the *Mode* pull-down menu.
   - Click the ‘Draw’ button.

4. **Draw the curve:**
   - Click and drag to draw the cursor path through the surface features of interest.
   - Once the mouse button is released, the line becomes a series of square points.
   - [Optional] By click-dragging these points, the user can modify the curve.

5. **Finalize the section:**
   - Click anywhere on the image away from the curve.
   - The square points disappear and a section graph will appear on screen.

**Plotting Multiple Line Sections on One Section Plot**

1. Make a section of an image layer using one of the methods described above.
Create a copy:

2. In the section graph window click the ‘Take a “Snap Shot” of active trace and append to upper graph’ button. The current trace is copied to a second graph, while the bottom graph is empty and awaits a new section.

Optional Double click the upper graph and change its color.

3. Make another section of an image layer as described above. A new section will appear in the lower graph.

Overlay multiple sections:

4. Click the ‘Snap Shot’ button again to join the lower graph with the other curve on the upper graph.

- Repeat this process as many times as needed.
- ‘Ctrl’+click the ‘Snap Shot’ button to append the section to an invisible left axis. This is good for comparing sections of different data types, such as phase and amplitude, as the section will not need to share the same axis range.
- ‘Shift’+click the ‘Snap Shot’ button to simultaneously append the marker distances, found in the bottom half of the section panel, to a notebook.

Exporting Sections as ASCII: Click the ‘Edit’ button on the Section Graph. This will create an X,Y delimited table from which the columns can be copied and pasted as text into any other program.

1.3.3. Histogram tab

When to use: This panel allows you to view histograms of image data. Histograms are the result of taking data arrays and counting how many times a value falls within various ranges of values, called bins. This can give an estimation of the probability distribution of the data.

How to use:

1. With a Display Window image open and the desired image channel as the selected tab (for example, Height Trace HtT in Figure 1.3 on page 9), click the ‘A’ button to open the Analyze
Panel.

**Histogram Analysis Panel:**
- Click the Histogram tab.
- Click on the ‘Make New Histogram’ button and a histogram graph will automatically come forward.
- If you have a histogram graph already up, you can append to that graph with options to the right of the ‘Make New Histogram’ button.

**Histogram Result Graph:**
- You can put multiple histograms on a single graph, from the histogram tab, there will be a pull down menu to the right of the Make new histogram, listing the existing histograms, select one of those, and you will append the current data set to that histogram.
- The Select histogram control on the histogram graph will set which distribution the rest of the controls work on.

### 1.3.3.1. Fitting
- There are 3 distributions built into the software: Gaussian, Poisson, and Lorentzian.
- Select the model, then click the ‘Fit’ button. There are more options in the pull-down menu to the right of the this button.
- The parameters from the fit are displayed under the ‘Fit’ button.
- To append the fit parameters to the graph, use the pull-down menu to the right of the ‘Fit’ button and select *Label Fit*.
- To fit a subregion of the distribution, mark the start and stop with the cursors. Press ‘Ctrl’+’i’ to show the info window, then drag the circle and square to mark the start and stop of the fit region.

### 1.3.3.2. Data Modification
To do offsets of the image data, place the cursors at the positions you want to be zero. Press ‘Ctrl’+’i’ to show the info window. Then drag the A (circle) or B (square) cursor where you want zero to be. Then go to the *Commands* pull-down menu and select *Set cursor A to 0* or *Set Cursor B to 0*. 
1.3.3.3. Other Options

Edit
This button will bring up a table of all the values of the image that created the current histogram. You can press ‘Ctrl’+‘A’ to select all the values, then copy and paste them into any program.

Bins
You can adjust the slider to change the number of bins in the histogram; if you have multiple histograms, the ‘Link Bin Sizes’ checkbox will ensure that all the histograms have the same bin size.

Mask
Place Igor cursors around the region you want to have masked. From the Commands pull-down menu, select Make Mask from Cursors. Now that there is built in histogram on the mask panel, this is not as useful as it once was.

Crop
You can crop data outside the cursors from the Commands pull-down; this will remove data from the histogram outside of the cursor range set. This is useful if the wide distribution of a few data points makes it difficult to see details in the distribution.

1.3.4. Particle Tab

When to use: This tab allows you to analyze particles or features of an image defined by a mask.

How to use:

1. Create a mask that defines the particles on an image. To bring up the mask panel click the ‘M’ button on the image window and select the Mask tab.

2. Open the Analyze panel by clicking the ‘A’ button on the image window, then select the Particle Analysis tab.

3. Click the ‘Analyze Particles’ button. When the software is finished analyzing, all of the particles will be selected. To select only the particles you want, hold down the left mouse button and drag the cursor over them.

4. Click the ‘Detailed Stats’ button. This brings up the Particle Analysis Stats Panel, which will display the attributes of the currently selected particles.

5. From this panel, you can graph the attributes by clicking on the buttons to the right. The left most button is for a histogram, the next button is for a distribution, and the last two are for plotting Y attributes vs 1 or none X attributes. See Step 4 on page 49.

1.3.4.1. Particle Analysis Example 1: Finding the Length of a Piece of DNA

In this particular example we will be using an image of DNA on mica. You can download this image file here: http://www.AsylumResearch.com/Files/Data/FlatteningExample1.zip. We will use skeleton erosion to find the length of a strand of DNA. This method works best on thin particles with curves, where a straight line measurement is not appropriate, which makes DNA a good candidate.
1. Flatten Image

- This is the same image used in the flatten example. For details on flattening the image, see Section 1.2.1.1 on page 14.
- For this experiment, the image should already be flattened and it should appear as it does to the right.

2. Apply Mask

- From the Mask tab on the Modify panel, apply an appropriate mask that covers the DNA completely, as shown in the figure on the right.
- For details on applying a mask, see 1.2.4.

3. From the Particle Analysis tab on the Analyze panel (Figure 1.17a), click the ‘Analyze Particles’ button. A progress bar will appear (Figure 1.17b) and a blue overlay will appear on top of the mask (Figure 1.17c).

Figure 1.17: Analyzing Particles
**Selection of Particles**

4. When the analyzing of the particles has reached completion, all of the particles will be selected in a green outline.

**Reset the Mask**

5. On the Mask panel, you can reset the mask to make it easier to see the particles.

**Un-Select the Particles**

6. Left click anywhere on the surface to un-select all of the particles.
   - Then, move your cursor over to the upper left strand of DNA.
   - When the cursor is over it, the particle will turn green.
Detailed View

7. Right click on the particle and choose ‘Detailed View of Particle’.
   This will open a detailed view of the particle as shown in the figure to the right.

Start Skeleton

8. Click the ‘Start Skeleton’ button.
   The particle will change to a lighter orange, as shown in the figure to the right.
   Click on the ends of the particle with the mouse cursor; these two points will be shown in blue.

Note  The skeletonizing process works by eroding the particle until it is a single line thick. It is possible and often occurs where the resultant skeleton will have multiple branches. The two points choose are considered safe and can never be eroded, so they preserve their respective branches, while any other possible branches are completely eroded away.

9. When you like the end points selected, click the green check box button.
10. Completed Skeleton

- Another progress bar will appear. When it is finished you should see something like the figure to the right.
- In our case we see the skeleton consists of 4 segments: a light blue segment at top, a green segment at the bottom, and two tiny segments in the middle (yellow and violet). This happened because the mask itself had a tiny hole in it which caused a loop.
- If you mouse over the different segments they will highlight with their individual distances displayed at the mouse cursor. Clicking on the segment will show it and other clicked on segments combined distance in the upper right.

Note The software automatically calculates the shortest path and displays it in white underneath the segments. In this case it is a combination of the blue violet, and green. If you zoom in you will see the yellow segment is longer than the violet and not needed to make the shortest path. The combine distance is shown as a tag. In this case we get 696.81nm long. Your results will vary depending on the end points chosen.

1.3.4.2. Particle Analysis Example 2: Finding Average Height

In this example we will be finding the height of the raised features (particles) of a SEB sample. You can use the provided SEB image: . We will used the modified height layer which has already been flattened.

Create Mask

- To start, we first must create a mask to define the particles just like in Section 1.3.4.1 on page 44.
- In the figure on the right, the mask was calculated as an iterative mask, then eroded twice to make sure to exclude the boundary portion.

Note Since we are only looking at the height of the particles we do not have to check the "Ignore Edge Particles" checkbox. If we were interested in the geometry of the particles we would want to ignore the edge particles.

2. Click the ‘Analyze Particles’ button. After it has finished, you may click the ‘Reset Mask’ button on the mask panel to remove the mask from the image. By default, all of the found
particles will be selected with a green outline.

3. Click the 'Detailed Stats' button. A new panel will come out with a list of attributes. The value displayed next to each attribute is always the average of the selected particles. Since we currently have all of the particles selected, we are looking at the average of them all.

Find the Height of Raised Features

- We want to know the height of the raised features, and have 3 different values to use:
  - MaximumZ: The largest height found on the particle
  - CenterZ: The value of the exact center of the particle
  - Average Z: The height value averaged over every pixel of the particle

- The first two options are more appropriate for spherical particles. In this case we will use the Average Z. So at this point we have the Average of all the particles’ Average Z. The value is 21.242nm as shown in the figure to the right.

Distribution Plot

- If we click the second button to the right of the Average Z value we can bring up a distribution plot.
- Notice that over 90% of the particles are below 30nm with a few that are much higher. These high values are due either to impurities on the sample or to the tip having trouble tracking.
6. **Change the Range**
   - If we look at the image with a large range, the particles we are interested in get grayed out but the offended areas remain white.

7. **Remove Offending Particles**
   - We could simply shift click on the 3 offending particles to remove them, but doing it by hand is not always ideal.
   - Instead, from the Particle Analysis panel, click the ‘Filter’ button. A filter panel will appear.

8. 
   - Click the checkbox next to Average Z.
   - Change the filter type to *Less than* *<*. In the high value enter 40nm.
   - Click ‘Find Particles’. The software will then select only those particles that have an Average Z of less than 40nm.
   - The selected particles should look like the figure to the right, with the 3 offending particles not selected.
Histogram of the Data

- Recheck the stats panel and see that the Average Z value has changed to 20.170nm.
- Click on the button just to the right of the Average Z to bring up a histogram of the data.
- Change the bin size and then apply a fit of the histogram data to can get a Mean and Standard deviation value.

1.4. Miscellaneous Operations

Below are some useful operations for image processing.

1.4.1. Saving Modifications to Images

Any image modification can be saved by going into the Commands pull-down menu, and selecting Save Image, Save as..., or Save then Kill Image. Save as will ask you to rename the file, then to select the path you want to save the image to. Save and Save then Kill will both save over the original file, but Save then Kill will close the image after saving it.

You can also save multiple images from the list panel. Select the images from the Memory column on the right, then click on Save or Save as. Save as will ask for a new location in which to save the data.

1.4.2. Custom work on Image Channels

1.4.2.1. Extracting Layers

A copy of an image layer can be extracted into its own image containing just that layer. Math can then be done on that layer, or the layer can be packaged into individual files.
Select layer to extract:

1. With the desired channel as the selected tab, click on Extract Layer in the Commands pull-down menu.
2. Optional: ‘Ctrl’+click on one of the 6 letter buttons to set it to Extract Layer, as described in Section 1.1.3.1 on page 12.

View the extracted layer:

1. Open the List Panel (See Section 1.1.2 on page 8).
2. To view this file, double click ‘LayerData’.

Note

If you intend to extract several layers in succession, you must rename the LayerData name manually between extractions. The LayerData name gets reused and overwritten with every extraction. To rename the layer, select the LayerData file, and choose ‘Rename Images’ from the List Panel. There is an advanced command line technique for extracting multiple layers without renaming, described below in Section 1.4.2.2 on page 52.

1.4.2.2. Subtracting Image Layers:

Subtracting image layers entails a pixel by pixel subtraction of one image layer from another. This can be useful for comparing lateral trace and retrace data.

You can download the file for this example here: http://www.AsylumResearch.com/Files/Data/SubtractExample.zip
Extract the first image layer:

1. In the Display Window of the image layer you wish to perform the subtraction on, select the lateral retrace image, and then select *Extract Layer* from the *Commands* pull-down menu.

2. The Images in memory column of the List Panel will now have LayerData as a choice.

**Optional** To see the image, select LayerData and click the ‘Open Images’ button.

3. Back in the List Panel, select LayerData in the right column. Click the ‘Rename Images’ button. The New Name dialog will appear; enter any name to finish the renaming process. In this example, the new name is LatRetrace.

-OR-

4. In the command line, rename that extracted layer to whatever you want. For this example, the command would be:

   Duplicates/D layerdata LatRetrace

Extract the second image:

5. Go to the lateral trace image, and select *Extract Layer* from the *Commands* pull-down menu.
4. In the command line, subtract one channel from another:
   \[
   \text{Layerdata} = \text{Layerdata} - \text{LatRetrace}
   \]
   -OR-
   \[
   \text{layerdata} -= \text{LatRetrace}
   \]

5. Reinsert the result:
   • Reinsert the layer (See Section 1.4.2.4 on page 55) into the original image.

1.4.2.3. Rotating Images:

In some rare instances, an image must be rotated, typically by increments of 90°.
1. Extract the desired layer (See Section 1.4.2.1 on page 51).
2. In the command line type:
   \[
   \text{RotateImage(LayerData,Degrees)}
   \]
   where Degrees is the angle you want to rotate the image.
1.4.2.4. Reinserting Layers:

Once an extracted image layer has had some changes applied to it, it can be reinserted into the original image.

1. Only the last extracted layer can be reinserted.

Open the Original Image:

- From any Image Display Window select *Insert Layer* from the *Commands* pull-down menu. The software will automatically send the LayerData back to the original image.
The Insert Layer Dialog Box:

- The Insert Layer window will pop up.
- Either choose to overwrite the original layer from which the layer was extracted, or to direct the data to a new modified layer tab.
- Notes can be added to the new layer in the large text box.
- Click ‘Do It’.

1.4.3. Cropping Images:

Cropping images is relatively straightforward. This section will discuss basic image cropping by eye first, and precision cropping second.

1. Either copy the .ibw file in Windows or extract a layer (Section 1.4.2.1 on page 51) before cropping an image; cropping will delete the excess data, so it is generally safe practice to crop a copy of the data lest in order to protect raw data.

2. Zoom in on the Area of Interest:

- Click+drag an area of interest.
- Right click and select ‘Expand’ or ‘Square Expand’ from the popup menu.
- You can then ‘Alt’+drag to pan the view.

Note Square expand only works for offline data, not real time imaging.

Notice The scales do not have their origin at zero.
Crop and Save:

- Go to the Image Window Commands pull-down and select Crop Image.
- Optional: Go to the Image Window Commands pull-down and select Save or Save As.

Notice The scales have their origin at zero after the cropping. The image here was taken just prior to cropping.

Precision Cropping

There is a way to crop more precisely:

1. Double click on the number labels of an axis of the image, or select Graph Modify Axis from the menu bar. This opens the Modify Axis Panel.
2. Manually enter the cropping area under the Axis Range tab. Note that it is necessary to enter values in meters, so 1e-6 represents 1 µm.
3. Go to the Image Window Commands pull-down and select Crop Image.
4. Optional: Go to the Image Window Commands pull-down and select Save Image.

1.4.4. Igor Layouts

Many graphs have a useful item referring to exporting or appending data to a layout Section 1.1.3 on page 9.

- Any data you have worked on in the offline analysis can be put into one of these layouts by clicking the 'Layout' button.
- To save the layout, go to File Save Graphics. In the dialog box you can determine the name, path and file type of the layout.
- Use the Igor tool box (‘Ctrl’ + ‘T’; upper left corner) to add text or shapes to the layout.
Ch. 1. Introductory Image Analysis  Sec. 1.4. Miscellaneous Operations

(a) Saving the layout as Graphics file  (b) Igor Layout Example

Figure 1.19.: Igor Layouts
This Section discusses how to perform basic force analysis on stored force (.ibw) and force map (.ardf) files. Keep in mind, there are not necessarily hard and fast rules / sequences regarding data processing; it depends on the data, and can be a trial and error process. For this reason, the processing techniques are broken into sections, and some examples given.
2.1. Opening Stored Force Plots

Prepare the software

1. • Launch the AR software and you will see the mode master window.
   • OR, click the Mode Master button at the bottom of the screen.
   • Click on the ‘Standard...’ tile.
   • Then Offline Force.

Open the Force Review directly:

2. • Alternatively, you can open the force review panel from the menu bar; select AFM Analysis ➤ Master Force Panel

Select a directory of Force plots:

3. • If there is no force data already loaded in the experiment, the force review will ask you where you would like to load data from when it is opened.
   • For a new directory, hit the Load button (bottom left corner of panel) and select the directory.

Select a force plot to open:

4. • Select a force plot from the list near the middle of the panel., section 2 in 2.1.
   • Make use of the various data display options outlined in Section 2.2.2 on page 62 if desired.
2.2. Display tab

2.2.1. Loading and Deleting

Loading

- When the force review panel is first opened, it will ask where you want to load data from. You can re-open this dialog with the folder icon in the lower left corner of the panel.
- You can also double click a force plot from windows (operating system) and have it come up in the force review, these force plots will be stored loose in the "memory" folder. You can also double click force plots from the offline image browse graph, which will load the force plots into this force review software.
- The list in the middle of the panel are the available force plots, sorted by folder, selecting one or more (hold down shift for contiguous section, or Ctrl for multiple non-contiguous).
- There is a distinction between listed in the software and actually loaded. Loading all of the force plots at once can present many problems with computer memory, so there is a title that

Figure 2.1.: Box 1: Adjusting the Display Box 2: Navigating the Data Box 3: Load and Delete
specifies how many are loaded and how many are simply listed. Once you need the data (generally for display), it loads the force plot, and it remains in memory until removed. You can load all of the listed force curves into the experiment with the load listed curves button.

- This is dangerous with large data sets on older computers, as it can most likely result in running out of memory errors.

![](image)

**Figure 2.2.: Load and Delete**

**Deleting**

- Deleting refers to removing the force plots from the Igor experiment; it never deletes ibw files from the hard drive. Force plots can be saved 2 ways, directly to memory, and / or to the hard drive as ibw files (or ARDF force maps).

- The default is to save force plots to both disk and memory, and force maps only as ARDF to disk.

  - If you change the default, so that you only save to memory, and then click on the delete all button, that is deleting your only copy of the data.

- You can also delete subsets of the listed data, with the select & delete button and the delete displayed buttons. Select & delete will present you with a dialog to delete some of the force plots. The delete displayed button will remove the currently displayed force plots.

### 2.2.2. Adjusting the Display

**Y Data** The controls at the top of the panel are for selecting what is shown on the Y axes of the graph. When you select a force plot for display, the text color of the channels are changed:

- Black = all of the selected force curves have the channel.
- Blue = some of the selected force curves have the channel.
- Grey = none of the selected force curves have the channel.

All of the selected channels from a given axis can be removed with the Select None button at the bottom of each list. You can display additional channels on any axis, but it generally works better to give each channel their own axis. You can show up to 5 axes with the control at the very top of the Force display panel.
**X Data**  All of the Y data channels are plotted against one common X data channel, which is set with the X axis popup. Typical X data types are:

- Zsnsr, heavily filtered Z sensor.
- Raw, minimally filtered Z sensor.
- Time, starting from the begining of the force plot.
- Sep, Tip-sample separation calculated from Z Sensor and deflection.
- Ind, Tip-sample indentation, calculated from Z sensor and deflection.

**Note**  Both Sep and Ind require that invols is correctly calibrated.
Section  The force plot is broken into various sections:

- Extend (Ext), where the tip is approaching the surface.
- Retract (Ret), where the tip is withdrawing from the surface.
- Dwell towards (Towd) the surface.
- Dwell Away (Away) from the surface.

You can control which sections are shown in the middle left of the display panel.

Advanced  There are more advanced, lesser used display options on the prefs tab. See Section 2.3 on page 66.

2.2.3. Navigating the Data

**Figure 2.5.:** Navigating the Data

Viewing Force Plots

- Use the list to directly select which force plots you want to see. It is often useful to collapse the list when switching between folders (force maps). Clicking on the expand button will change to the collapse button, and then clicking on the collapse button will collapse all folders. Clicking on the ± sign to the left of the folder will expand / collapse a single folder.
- Use the ribbon of buttons to adjust the list, jumping to the next or previous force plot in the list, adding or subtracting from the number of displayed force plots (+ - buttons).
- You can also use the keyboard:
– Right or down arrows will move to the next force plot.
– Left or up arrows will move to the previous force plot.
– Page up / page down will move up or down in the list by larger step sizes (12 on most computers).
– Home and End will move to the first or last force plot in the list.
– + or - will add or subtract one of the force plots to the graph.
– These can be done from any tab of the force review panel, or from the force review graph.

**Figure 2.6.** Use the movie button to bring up this small panel to play through the force plots in a slide show. Most of this panel is explained with the in software tool tips (ctrl + 1 to toggle tool tips on or off).

**Movie Player**
2.3. Pref tab

![Pref Panel](image)

**Figure 2.7.: Pref Panel**

**General**

- This panel is for advanced formatting of the force review graph. If you are familiar with Igor, you know there there is very large set of display properties that you can set - line width, line style, Markers, etc, etc, etc.

- This panel has a system of determining what user actions have been done to the force review graph, and recording those actions to apply again. This panel refers to that as the macro.

  - Note that macro has many other meanings in different context.

- The top of this panel turns on or off the Macro, the bottom of the panel updates the macro, and can open up the macro in a table for direct editing.
• This falls into the grey area of pseudo coding, where there is enough flexibility to really mess things up. The Reset Macro button will put the Macro back to the default state, and is a good safety measure, because the changes you make to the macro will be automatically saved to disk and reloaded the next time you start Igor.

**Line Style**

• The default line style is to display the force plots with solid lines when only a single data type is on a given axis, but to switch to data type specific line style when multiple data types are on the same axis.

• You can set this to be always solid or always set by data type, or to call a user specified function to set the line style.

• The data type specific line styles are also set here.

![Line Style](image)

**Figure 2.8.** Line Style

**Line Color**

• The default line color is to display each section (Extend, Retract, Dwell) as a different color when there is only one force plot on the graph.

• When there are multiple force plots it automatically gives each force plot a different color from a color table lookup. The color table can wrap around, so if enough force plots are shown, it will reuse the same colors.

• You can set this to be always color table or color by section, or to call a user specified function to set the line color.

• If you have multiple force plots on the graph, you can double click on the trace, and then change it’s color. Then on the force graph, there is a split button, labeled review graph.

  – Click on the drop down list to the right of that and there will be an option to Update Color Table. This will look at the graph, and see what has changed, and then update the color table so that the next time you build a graph, it will use your color. You should also see the lower list on the force display panel update with your new color.

  – There is also an update color table button on the prefs tab.
X Orientation

- If this is set to “Keep surface to the left”, then most data types will have the surface on the left.
- If this is set to "Keep surface to the right", then most data types will have the surface on the right.
- Indentation is the opposite of other data types (surface will be on the right, when set to keep on left).
- Time is increasing when the surface is set to the left.

Miscellaneous

- Auto Stack Y axes is on by default, which means the Y axes will be placed so they do not overlap. When this is turned off, then all the Y axes will be overlapping on top of each other.
- The Macro controls are discussed at the beginning of this section.
2.4. Parm tab

This panel list the parameters associated with each force plot, some parameters are editable and when changed, will update the data. Most parameters are simply viewable.
Figure 2.12.: Parm Tab

Editable Parameters

- The top half of the panel is dealing with parameters that can be changed, mostly calibration.
values, such as spring constant and invols, or scaling factors for user channels. Only the first 5 displayed force plots have their parameters shown.

- Once you have made a parameter change you can then apply that change to:
  - The selected force plots with the ‘Set Selected’ button
  - OR -
  - All of the force plots listed in the display panel with the ‘Set All’ button.

  Note: This is very memory intensive, as it tries to load all of the force plots in order to apply the modification. Old computers typically cannot deal with 1000’s of force plots.

Parameter Search

- The bottom half of the panel is reporting the rest of the parameters. It works well if you can guess part of the name of the parameter you are interested in, just type it into the Search field, and the resulting list will be reduced to those that match the search string.

- The copy button will take the resulting list of matches (or the selected lines) and put it in the clipboard. You can still use the keyboard shortcuts when this panel is topmost (left / right arrows go to the previous / next force plot). Only the first 5 displayed force plots have their parameters shown.

2.5. Cursor tab

![Master Force Panel](image)

Figure 2.13.: Cursor Tab

This panel is primarily for marking regions of interest (ROIs) for the Worm Like Chain (WLC) tab 2.7.

You can set the ROI at any time on the Force review graph.
• **To set a new point:** Shift + Left click on the trace at a new point.
• **To select an existing point:** Shift + Left click on an existing point.
• **To deselect an existing point:** Shift + Left click on the selected point.
• **To change the selected point:** Drag the A cursor after selecting the point of interest.
• **To remove a point:** Ctrl + Left click on an existing point.

The cursor tab modifies the behavior of how the above Force review graph shortcuts work, as described below.

### Limiting

You can limit where you put new markers by segment and by force plot. This can be useful if the data is overlapping and you want to make sure you put the markers on one specific trace.

- To limit by section, use the list box, the checked segments are segments where the markers are allowed. Turning off a section will also remove any markers in that segment.
- To limit by trace (only useful if you are plotting multiple force curves).

### Clearing

You can clear markers from traces by:

- The clear locks from trace popup menu, and select the trace you want to remove from.
- Turning off sections, the markers will be removed from the excluded sections.
- Ctrl + Clicking on the markers you want removed.

![Figure 2.14.: Clearing and Highlighting](image)

### Highlighting

You can make the markers on one of the traces larger with the highlight locks from trace control.

### Editing

- You can modify a marker by shift clicking on it (you may need to zoom in if there is another marker near the one of interest). You should see a circle around the marker, you can then drag that to another location, or use the arrow keys (left or right) to move the position of the marker.
- For more advanced editing, the locks field in the editable parms can be used to update the markers. See Section 2.4 on page 69.
2.6. Modify tab

![Modification Panel](image)

**Figure 2.15.: Box 1: Modify Box 2: Undo/Redo Options Box 3: Save Options**

2.6.1. Modifications

Offsets and lines can be removed from the data. These operations work on the currently displayed force curves or all of the force plots listed. Operating on all the force plots listed can be extremely memory intensive, it will need to load the force curves into memory, do the modification and keep the data in memory. Older machine running Win XP can not deal with very large data sets. It is better to break the data into smaller data sets, (move groups into sub folders in windows), or only modify the data as needed.

**Automatic Offsets**

- These operations are in terms of X and Y axes, whatever the force plot is displayed as. The offsets find the zero point in the Retract or the extend data (based on the state of the radio buttons to the left). see also: Offset algorithm below.

**Manual Offsets**

- You can right click on the force review graph, and select X, Y or XY offsets. The position where you click will be put to zero for the axes selected.

**Line**
• You can subtract a line from the data as well, just press ctrl+i (i for info) when the graph is
topmost and drag the A (circle) and B (square) cursors to define the region you want to fit to
a line. The line is extrapolated over the entire force curve, and the line subtracted.

Offset Algorithm
• The Y offset will take the average of the last 10 points for retract data, or the average of the
first 10 points for extend data as the zero point. If your force plot was taken using the indenter
panel (or indentation master panel), then the offset is taken as the min of the dwell towards
the surface.

• The Raw (X) offset will use the function GetContactSlope to find the rough estimate of the
surface contact point. It does this by fitting the slope of the deflection vs ZSnsr in small
(~7 points) chunks until the slope is > 0 (see function FindSurfaceIndex). It then fits the
deflection from 20% force to the contact point, and extrapolates that line to where it intersects
the zero force.

  – If you do not have deflection data, then this function will not modify to the data.

Note This is the simple algorithm, the elastic panel has a much more involved iterative method of
finding the contact point better. See Section 2.10 on page 84.

2.6.2. Undo, Restore and Save

These operations all work on:
• The last modified force plot
• A selected subset of the force plot
• All of the force plots listed

Save FMap will work on:
• A single selected force map
• All of the force maps listed

Attention Typically operating on all force plots listed is memory intensive, but the Save
As All operation will remove force plots that it loaded as it goes, so the total
amount of memory used for this operation should be minimal.

Undo
• These buttons will toggle between undo and redo. They undo all of the last TYPE of change.
• For example, you change the InVOLS on a force plot 20 times. Clicking undo last, will undo
all the InVOLS changes and revert the force plot to it state before any InVOLS changes have
been made.
Ch. 2. Force Curve Analysis  Sec. 2.7. WLC Tab

**Restore**

- These buttons will restore the specified force plots to their "Original" state, which is typically the hard drive state. For force plots only saved to memory, there is an extra copy of the data before modifications were done to the data that is used.

![Restore buttons](image)

*Figure 2.17.*

**Save**

- **Save** and **Save As** will save IBW files. If the source is an ARDF, it will convert to the old loose style of ibw files. Be careful with this since you may end up with a large number of files, making things slow; it can however be useful for exporting the data into other packages.

- **Save As** will ask you once for the root folder you want to save to. You cannot rename files, as it is possible to save many many files with this operation.

- **Save FMap** will save ARDF files, which are packages of force plots. If the selected force map is really from ibw files, it will still save as an ARDF, so this is a good way to convert old style force maps to newer ARDFs.

  - The **Save FMap** only works on a single selected force map, or all of the force maps listed in memory.

![Save buttons](image)

*Figure 2.18.*

**2.7. WLC Tab**

This panel is used to fit polymer stretching events to the Worm Like Chain (WLC) model.
2.7.1. Force WLC Models

The Multi Chain checkbox switches between the Single Chain (multiple attachments) and the Multiple chains (single attachments) models.

The difference between these 2 extremes is in how the stretching events (Hitches) are added together:

- **Single Chain**, then it adds the WLC response only in the error region.
  - Applicable if each response is NOT influenced by the other stretches.

- **Multi Chain**, then it adds the WLC response to the entire stretch.
  - Applicable where the observed response is the sum of the individual responses.

The difference between these 2 cases can be made more apparent by turning on the “Show Individual Stretches” checkbox.

If the single pers checkbox is selected then all the stretching responses are fit to one persistence length. If you believe that all the stretching events are from the same type of polymer (in particular the single chain extreme), then selecting this will force each response to have the same persistence length.
2.7.2. Getting Started

How to fit force plots with the WLC model:

1. Find the force plot you want to fit.
2. Plot it as Force Vs. Sep (Sep is short for tip - sample separation). The X axis is controlled with the Force X axis popup menu beneath the Y axis data type list, on the Display tab.
3. You need to define where 0,0 is. To set the offsets you can either right click on the graph to offset X and Y, so that the force is zeroed, and the tip hits the surface at zero separation, or go to the Mod tab, and click on 'Y offset' and 'Raw (X) offset'.
4. Go to the cursor tab, select that you only want cursors on Ret (short for retract) Force Cursor Sections.
5. Shift + left click on the graph to define the stretching regions. You want to define the error region of the fitting function, so pick one point where the polymer ruptures its attachment to the tip, and pick the other point at the lowest extension as the data looks like it will be fit. You can fit multiple stretching events in a single force plot. If you want to do that, pick two "locks" (cursors) to define each stretching event (the software calls polymer stretching events hitches).
6. Open the WLC tab. Make sure that the initial state of the parameters is close to the data; the fitting function often throws up its hands in despair if the initial guess is too far from the data.
   a) The Pers is the persistence length; it is basically a measure of the polymer’s stiffness. Lower persistence lengths have much more non-linear responses.
   b) The extension ratio is the fraction of the contour length that the polymer chain is extended. The fit parameter is the extension ratio where the polymer chain ruptures its attachment to the tip (max extension ratio). So you can get the contour length of the chain from the rupture length divided by the max extension ratio.
7. Once you have your fit parameters fairly close to the data, you can then click ‘Fit’.
8. If you have multiple hitches in a force plot that you want to fit, then there are two questions you have to answer.
   a) Is the observed response due to one chain with domains or loops; or is each hitch the result of stretching a separate chain? If you think you have a single chain, then you want to unselect Multi Chain (upper left corner) Force WLC Models. If you think that each hitch is from a separate chain, then select Multi Chain.
   b) Do you think that each hitch should have the same persistence length? Generally this is the case, but is not required by the fitting function. If you want to fit each hitch to a single persistence length, then select Single Pers; if you want each hitch to have its own persistence length parameter, then unselect Single Pers.
9. You can also hold and constrain each of the fit parameters using the hold and constrain checkboxes.
   a) Hold means that the fitting function will hold that parameter constant and not fit it.
b) **Constrain** means that it will keep the fit parameter between the upper and lower limits (the limit controls show up after you constrain one of the parameters. The constrain option does not always work well, often when the fit fails, it will run the parameter into the limit.

10. Once you like the fit, you can show the individual responses by clicking on the ‘Show Individual Stretches’ checkbox. Then you can label the contour length of each response with the ‘Tag Stretches’ checkbox.

11. You can also tweak your fit with the Max Iterations and Fit Tolerance. You can specify the temperature at which the stretching was done with the temperature control.

### 2.8. Analyze tab

#### 2.8.1. Single Force Plot Tab

This tab runs various analysis (built in or user) on collections of force plots or force maps to create histograms, plots and images of calculated parameters from the force data.

**Figure 2.20.: Single Force Plot Tab**

**Histogram** This check box creates a histogram of calculated values. On the single force tab, you can set which force plots will be used to generate the histogram in the upper left corner. Either all of the force plots listed (this can be memory intensive), or a selected subset of the data. The various parameters that can be calculated are:

- Adhesion
Ch. 2. Force Curve Analysis

Sec. 2.8. Analyze tab

- Simple minimum of the force curve, appropriate for clean adhesive ruptures with no polymer tethers.

• DC Invols

  - Calculates the slope of deflection vs Zsensor in the contact region, can use extend or retract data.

• AC Invols

  - Calculates the slope of Amplitude vs Zsensor in the contact region, can use extend or retract data.

• Indentation

  - This takes the difference in the indentation at two marked points in the force plot. You need to mark the start and end points of the indentation with the cursor panel controls.

• Pers

• Contour Length

• Extension Ratio

• Rupture Length

• Rupture Force

• Young’s Modulus E1

• OliverPharrFit

• OliverPharrStiffness

• OliverPharrReducedDepth

• OliverPharrArea

  - These are all report values that were calculated from other methods (WLC or elastic tab). When these calculates are done, they store values in the wave notes, the histogram or scatter plots are simply reporting those stored values.

Scatter Plots

• You can create scatter plots of a calculate value vs another parameter. This calculation shares most of its controls with the histogram, the force plot selection, the calculation type are the same as the histogram.

• The X axis of the scatter plot is set by the X parm popup, just under the calculate popup. These are generally parameters that are extracted from the force plot note, for example you can plot the adhesion vs. seconds to see how the adhesion changed over time.
Ch. 2. Force Curve Analysis  Sec. 2.8. Analyze tab

Force Average

- This takes the currently displayed force plots, and puts them on a second graph, which will be averaged along the X axis. It divides the X axis into evenly spaced bins and averages the Y data that falls into each bin.
- You can adjust the number of bins from a slider on the graph.
- It is critical for each of the force plots to be overlapping when you do this, if there is an offset in the deflection from one force plot to the next, then that is what the averaging will be showing you.

PFM Hysteresis Loops

- PFM Force plots that were taken in the DART spectroscopy controls (driving the DC tip bias with a triangle square wave while driving the AC tip bias with a sine wave) can be further analyzed with this button.
- It converts the raw data in the currently displayed force plot to a hysteresis plot of the average of the data while the bias is off, plotted vs the DC bias of the previous step pulse.
- More detail on this can be found in ARApplicationsGuide in the PFM chapter.

2.8.2. Entire Force Map Tab

Figure 2.21.: Entire Force Map Tab. Box 1: Input and Calculation Box 2: Optional Advanced Controls Box 3: Starts the Calculation

On this tab there are controls that will create images from force map data. Select the Input and the force map you want to use to calculate the image. Select the function. Below are descriptions for each of the functions:
**FMapCalcAdhesion** Calculates the adhesion by returning the difference of the minimum of the data and the average of the last 10 points.

**FMapCalcJKR2Point** Calculates Young’s modulus of the sample using the 2 point JKR method. Sun Y. et. al. Langmuir 2004, 20, 5837-5845. The First element of the Parm Wave is the radius of the spherical apex of the paraboloid tip, in meters. The second (optional) element of the parm wave is the Poisson Ratio of the sample [Default = 0, meaning that the result will be in Reduced elastic modulus, not sample modulus].

**FMapCalcHeight** Calculates the height by returning the negative max of the data.

**FMapCalcMax** This function simply returns the max value of the input channel.

**FMapCalcMin** This function simply returns the min value of the input channel.

**FMapCalcXMaxLoc** This function returns the value of the Data where the DataTypeB is maximum. EX: Data is deflection and DataTypeB is ZSnsr, then it would return the trigger point of the deflection.

**FMapCalcXMinLoc** This function returns the value of the Data where the DataTypeB is minimum. EX: Data is ZSnsr and DataTypeB is deflection, segment is Ret, then it would return the Z position of the adhesive rupture.

**FMapTransitionMap** Heavily filters the data, then returns the value of Data where the derivative of DataB is at a minimum.

**FMapCalcPFM(On/Off)** These functions extract the Hysteresis loops of the PFM measurements. The On version takes the data during the On cycles of the triangle square wave, the Off version takes the data when the DC bias on the tip is zero. These functions are specialized in that they build four layers: Coercive Imprint Negative Positive Bias is rising, is the loading cycle; Bias is Falling is the unloading cycle. Positive (Vp) is the bias at which the input channel is at a minimum during the Loading cycle. The negative (Vn) is the bias where the input channel is a minimum during the unloading cycle. The Coercive is (abs(Vn)+abs(Vp))/2 Imprint is (abs(Vp)-abs(Vn))/2.

**FMapCalcInvols** This function calculates the inverse slope of the contact region, between 10 and 90% of the Max force for that segment.

**FMapWork** Integrates DataType vs DataTypeB. The default section is ALL, so that it is returning the difference between the trace and retracesegment.

**FMapContactWork** Integrates DataType vs DataType B. Finds where DataTypeB is zero, and integrates the positive values of DataType vsDataTypeB from zero to the trigger point.

**FMapCalcPlasticity** Uses FMapContactWork to calculate the work for the extend data and retract data. Returns the ratio: (AreaExt-AreaRet)/AreaExt.

- These functions live in XCalculated.ipf. You can add your own functions to UserCalculated.ipf. XCalculated.ipf will be overwritten by the installer the next time you update your software. UserCalculated will not.

- For the most part, when using existing functions, you don’t need to worry about Data, DataB, Section and EditParms, those are for doing custom calculations, selecting the function will set the dataType, dataTypeB, and section to the default state. The auto name and output controls set where the image is going once it is calculated. If you point it to an existing image with a different number of points and lines, the calculated image will be interpolated to fit in the existing image. This way you can calculate images from force maps, and put them into typical AFM images.
• The ‘Do It’ button will start the calculation. The force map calculation will unload any force plots that it loaded to do the calculation, so that the memory footprint should not grow significantly while doing the calculation.

2.8.3. Examples

Adhesion histogram  In this example we will analyze a batch for force curves to obtain a distribution of adhesion. The software measures the adhesion by taking the difference between the minimum and the zero point. The zero point is defined here to be the average of the last 10 points in the non-contact portion of the curve. The minimum is the lowest point in the retract portion of the curve. Keep this in mind if using this application for polymer stretching force curves, where there may be a larger adhesion away from the surface, this analysis may not be all that useful.

1. In the Analyze sub-tab, select Adhesion from the Calculate pull-down menu.
   a) If ALL the curves are to be analyzed, activate the ‘Use all FPs’ checkbox
   -OR-
   b) Click the ‘Select FPs...’ button, which will bring up a panel to select the force plots.

2. Click the ‘Histogram’ checkbox.

3. Click the ‘Do It’ button. Igor will process and produce a histogram.

4. Within the Histogram window, a variety of information can be acquired or exported. Fits can also be acquired from the Fit Type pull down.

Invols Statistics Small improvements can be made in the precision of the Invols by taking a statistical average of many invols values. In this example we will calibrate the invols by taking statistics on a batch of force curves.

1. Collect a reasonable number of force curves (say 10-100) on a hard surface. Make sure they all have the same trigger point.

2. Load just those force plots into the force review software.

3. In the Modify sub-tab, click the ‘All Y’ offset.

4. Plot the force curves as DeflV, and note what voltage range you want to do the fit over.

5. On the analyze tab, select Calculate DC Invols Ret or DC Invols Ext, depending on which segment you want to use.

6. Two controls will appear to allow you to set the deflection voltage range to do the line fit over.

7. Click the ‘Histogram’ checkbox.

8. Click the ‘Do It’ button. Igor will process and produce a histogram.

9. Within the Histogram window, a variety of information can be acquired or exported. Fits can also be acquired from the Fit Type pull down.

10. Back on the analyze tab, there are two buttons:
   a) ‘Set to fit’ sets the invols of the analyzed force plots to the fitted mean.
   b) ‘Set to each’ sets the invols of the analyzed force plots to each have their own Invols value that was determined when creating the histogram.
2.9. Spot Tab

This panel will allow you to mark where a force plot was performed relative to the image coordinate system.

1. Turn the spots on and off using the Activate Spots checkbox in the upper left corner.

2. Select the force plots from the left column. This list is the same list as the one on the force display tab, so the offline force graph will update to display the selected force plots.

3. The locations of the force plots will be marked on the images selected on the right. Note that only the displayed images are listed. You may need to go to the list panel to open the images (note the List Panel... button which will open the list panel). To have the spot updated on the images, you need to have the ‘Activate Spots’ checkbox turned on in the upper left corner.

4. The Display Prefs (lower part of panel, click on the + to expand) allow you to set the text, color and marker properties of the force plot locations.

**Note** Moving the sample or tip in the holder (changing tips) will make this analysis useless. Additionally, when this analysis is appropriate, there may also be small errors arising from thermal drift that are not accounted for.
2.10. Elastic tab

This tab fits single force plots or entire force maps with various elastic models to provide elastic modulus.

Figure 2.23.: Elastic tab. Major interface areas are numbered and outlined below.

1. **Fit Input:** The upper left corner of the panel is where you can set it to work on a single force plot or calculate an entire elastic map from a force map. You can also set which segment of the force plots you are working on, extend, retract, or dwell.

2. **Calibration:** Here you can override the Invols and spring constant stored in the file. Clicking the red ‘X’ button in the corner of this area will undo the override values and revert the data back to the stored value.

3. **Warnings:** This area posts any problems that the software finds with your data. Clicking on the buttons here will take you to the help section that describes what the problems are, their implications, and how to fix / avoid the problem in the future.

   a) If your input is set to force map, then initially this will be a button with an estimate on how long it will take to load up a handful of the force plots. Once this has been done, it will list any problems found with the examined force plots.
b) Also if you have analyzed the force map, clicking on the ‘Warnings’ button will bring up a mask that shows which parts of the image had this problem.

**Model Selection Guide**

- This area posts suggestions on which models may describe the data better.
- It calculates the plasticity factor, the Force ratio and the Tabor coef and from those parameters selects one of the 4 available models that best works with those parameters, as seen in the flow chart to the right.
- When the fit input is set to entire force map, the model selection guide changes, and reports statistics on the force map that has been examined so far. The colors to the left of these controls reflect the colors of the mask applied to the image.
- There is a control to check the map, which loads and examines force plots randomly to get more statistics. This operation can be canceled at any time (from the progress bar panel that comes up).

5. **Models:** The tab selects which elastic model you are using. The Model Selection Guide (above) can give some guidance as to which models may describe your particular data.

   a) **Hertz** The classical theory of contact mechanics. From 1886 to 1889 Heinrich Hertz studied how lenses deform under load, and his equations led to the foundation of contact mechanics. See also 2.10.0.1. This model assumes:
   
   - Negligible adhesion between the tip and sample
   - Strains are within the elastic limit
   - The contact area is much smaller than the radius of the tip

   b) **DMT** Derjaguin-Muller-Toporov; Takes into account adhesion outside the contact area. Applies to samples with a small Tabor coefficient.

   c) **JKR** Johnson-Kendall-Roberts; Takes into account adhesion inside the contact area. Applies to samples with a large Tabor coefficient. See also 2.10.0.2.

   d) **Oliver Pharr** Relatively new elastic model that fits the unloading curve. More appropriate for samples that deform plastically.

6. **Model Assumptions:** This area describes the tip and the sample. The elastic models calculate the reduced Young’s modulus, which is comprised of the tip and sample’s Young’s
modulus and Poisson ratios. You need to describe the tip and sample in order to determine the sample modulus from the reduced modulus.

\[
\frac{1}{E_c} = \frac{1 - V_i^2}{E_i} + \frac{1 - V_s^2}{E_s}
\]

V is the poisson ratio, E is Young’s modulus, Ec is the reduced Young’s modulus i denotes indenter, s denotes sample.

a) The elastic models also deal with pressure, which means you need to know area and tip geometry, which is set in the geometry area. The Oliver Pharr model has more complicated and flexible controls to specify the area.

b) The tip geometry controls are above the model assumption. There is also an estimation of which geometry will describe your data the best, it is useful as a double check.

7. **Initial Guess:** The specifics of this area depend on the Elastic Model. In general terms, you can type in values for the fit parameters and see how that alters the calculated line. Then fitting will take that initial point and try to converge on a better description of the data. If the initial guess is very far from describing the data, the fit will not be able to converge.

8. **Results:** Here the sample modulus is calculated from the tip and sample properties and the reduced modulus from the fit.

### 2.10.0.1 Elastic Tab Hertz Example

This instruction set uses a force map that was collected on a homogenous polyacrylamide gel with a modulus of ~700 Pa. The instruction set will refer to specific force curves from this sample. You can download this sample data set from here:

http://www.asylumresearch.com/Files/Data/PolyacrylamideGel.zip.
1. Open the AFM software. In this example, we are using Igor PRO 6.32A and the MFP3D 120804+0806. Earlier versions of the AFM software (especially anything before 101010) may not work or have the features we use in this document. Please check the Asylum support site (https://Support.asylumresearch.com/forum/content.php?4-Software) for the latest version.

2. Load your Force Map data from the menu bar select **AFM Analysis > Master Force Panel**. A new panel called the Master Force Panel should appear, along with the AR Load Path window. Using the browse button on the AR Load Path window, select the folder that contains your force map data, see 2.2.1.
Open a Force Curve

3. You should now see a list containing all of your force curves towards the bottom of the Display tab of the Master Force Panel (Figure 2.24a on page 87).

- Simply click on the name of any one of your curves and a graph of the force curve will appear, in this example, we’ve picked the force curve located at Line 1, Point 1.

-OR-

- If an image came up with the force map, you can simply click on the image to display the corresponding force plot.

4. Select the Elastic tab on the Master Force Panel. The panel should now look like Figure 2.24b on page 87.

Note By default, the Elastic tab starts in single force plot mode, as evidenced by the blue ‘Single Force Plot’ sub-tab towards the top of this panel. This is a good place to start, even if you are analyzing an entire force map.

Inspect the Force Curve

5. The force curve will be displayed with force on the Y-axis and Indentation on the X-axis.

- Note the crosshair on the graph showing the location of the software’s current estimation of the contact point.

- Also note the software’s first fit to your chosen elastic model, indicated by a brown line. In the example, the first fit does not match the data very well, indicating that we have more work to do before we get a better fit on our data.

6. You can change the selected curve either by going back to the Display tab or by pressing the arrow buttons under the Fit Input grouping on the Elastic Panel. You can also use the keyboard arrow keys to navigate across adjacent curves. See 2.2.3. Also, we will use the extend portion (not the retract portion) of the force curve for this model, which should automatically
be selected in the drop-down box in this grouping.

7. Check your warnings: When the fit is made, the software checks for a series of common problems that are found in indentation data. The top-right corner of the panel will display any problems that have been detected with the data in yellow. Click the name of the warning for a description of the problem. If there are no issues detected, a green button labeled No Problems Detected will be displayed.

8. Input your model assumptions. Next, you will want to assume a tip shape, size Poisson ratio for your sample. These need to be entered into the model assumption grouping. The tip material is not required for soft samples, when the sample is in the kPa to a few MPa range, then the difference in a 60 GPa indenter and a 360 GPa indenter is negligible.

   a) In this case, we used an unmodified silicon nitride AFM cantilever, which we assume is a cone with a half-angle of 36°. For a PA gel, the literature reports various Poisson ratios- here we will use 0.4. Note that assumptions are very difficult to make, and in real-life situations it might not be feasible to expect that your assumptions are constant throughout a single data set.

9. Adjust your initial guess, if needed. The Initial Guess grouping allows you to assist the model in making first-order guesses. The Force Offset and Depth Offset are the X- and Y-locations of the contact point, relative to the 0,0 point in the force curve data. They describe the center of the crosshairs displayed on your force curve graph. When the boxes next to these parameters are checked, the program will try to solve for these offsets by iterative fitting.

10. Adjust the fit region, if needed. In many cases, only a subset of your curve will be amenable to a single model. By default, the fit is made between 10%-90% of maximum indentation. To select a smaller or larger region, press the Show Fit Region Controls Checkbox. Using the parameters shown, you can select a lower and upper bound by inputting a specific value or just a percentage of either the maximum force or indentation that will be fit by the model. If the low parameter is grayed out, that means that you are trying to fit the force offset, and the non-contact data is required to fit for that. Note that as you change the ROI parameters, your data graph may auto-zoom the graph window.

   a) When looking at these example force curves, you can see a small kink in the extend portion of the curve at about 50% of the maximum force application. This might be due to various factors that are not described by the model. In order to exclude this section of the curve from the model analysis, we can use the ROI controls to select a sub-set of the data for analysis.

11. **Fit your Data**

   • You will see the model fit represented as a brown dashed line on your force curve, and the numbers in the Results grouping will be updated. To the right we show a good fit on our data, which was obtained by rejecting all data above the kink in the force curve.
12. Look at the Results part of the panel. The modulus of the sample is highlighted in yellow. The reduced chi-square ($\chi^2$) value is an estimate of the fit quality, where values closer to 1 indicate a better fit. The reduced modulus is the actual measured modulus, which is a convolution of the sample modulus and the indenter modulus.

13. Start Over, if needed. This button removes the region of fit restrictions and allows you to start again.

14. Select Entire Force Map: Selecting this tab should result in the border of the panel turning green (Figure 2.24c on page 87).

15. Fit an Entire Force Map: We started by analyzing one force curve in order to adjust our fitting parameters and assumptions. We can now analyze an entire force map.

Note When you do this, you apply the same assumptions and fit parameters to every curve in the force map. This might not be appropriate as the variability of the sample and the tip during the experiment might require different assumptions for different areas.

16. Check for warnings: The warnings area of the panel should now give you the option to check a small subset of your data for fit problems. It will also list the estimated length of time that such a check will take. The warnings that appear here are identical to those described in the previous section.

17. Select your data output: Using the top left part of the panel, you can select the name of the image output. The AutoName checkbox is selected by default, and will produce an image with the same name as the folder that contains your force map data- this name will be listed just under the check box. Be careful if you do not check the box; adding the calculated data as a layer into a new image can be tricky, especially if you are adding it to an image file that has a different pixel count or scan size.

18. Fit your data: Select the fit button. A progress bar with an estimated time to completion will appear as the program fits the individual curves.

19. Explore your Data

• A figure with results should appear. Each pixel represents a modulus value.

• To see a point in more detail, simply click the point on the image. The force curve display will show you that force curve and the ‘Results’ area of the Elastic panel will show you the value.

Note Very poorly fit points will be displayed as dark red pixels. If you choose one of the problems noted in the Warnings panel, a bright red mask will indicate which areas represent the reported warnings.
20. Re-fit a specific point, if needed: If a single point has been fit poorly, or requires different assumptions or parameters, you can select that point and adjust the fit parameters in the Elastic tab, just as you would when analyzing single force curves. If your new parameters and result are satisfactory, you can then update the force map with the new value by selecting the Update value in map with current fit button.

Further Analysis (Optional)  In this example, the Force Map was taken on a homogenous gel. This was done so that many data points could be analyzed to achieve an average value for the sample. If you had a large data set (> 100 force plots), you could do a Gaussian fit to the distribution from the histogram panel. This example data set is only 16 force plot, so reading the average and standard deviation from the roughness panel is more appropriate, see 1.3.1. The histogram example is described here as an example.

- To show the Histogram tab, make the Analyze Panel by pressing A at the top right of your result map, see 1.3.3.

21. Further Analysis (Continued)

- Click on the ‘Make New Histogram’ button.
- The resulting histogram can be adjusted using the slider to control the number of samples per bin.
- A Gaussian fit can be applied to the data by selecting ‘Do it’ on the top right of the Histogram window. You can also fit a subset of the data by bracketing the region on interest with the Igor cursors (press CTRL + i to reveal these) and then doing the fit.

Note  In this example, the Gaussian mean value was 664.18 Pa with a standard deviation (Width) of 7.56 Pa. Compared to the actual average of 682.9 Pa and standard deviation of 8.183 Pa from the roughness panel.
2.10.0.2. Elastic Tab JKR Example

This instruction set uses a force map that was collected on Dow Corning Sylgard 186 Silicone Elastomer [http://www.dowcorning.com/applications/search/default.aspx?R=11&EN]. The instruction set will refer to specific force curves collected on this sample. You can download this sample data set from here:

[http://www.asylumresearch.com/Files/Data/JKRD.zip]
1. Open the AFM software. In this example, we are using Igor PRO 6.32A and the MFP3D 120804+1118. Earlier versions of the AFM software will not have the features we use in this document. Please check the Asylum support site (https://support.asylumresearch.com/forum/content.php?4-Software) for the latest version.

2. Load your Force Map data from the menu bar select AFM Analysis > Master Force Panel. A new panel called the Master Force Panel should appear, along with the AR Load Path window. Using the browse button on the AR Load Path window, select the folder that contains your force map data.

3. Open a Force Curve
   - You should now see a list containing all of your force curves towards the bottom of the Display tab of the Master Force Panel (Figure 2.25a on page 92).
   - Simply click on the name of any one of your curves and a graph of the force curve will appear in this example, we’ve picked the force curve located at Line 1, Point 3.
   - OR-
     - If an image came up with the force map, you can simply click on the image to display the corresponding force plot.

4. Select the Elastic tab on the Master Force Panel. Then click on the JKR tab. The panel should now look like Figure 2.25b on page 92.

Note By default, the Elastic tab starts in single force plot mode, as evidenced by the blue ‘Single Force Plot’ sub-tab towards the top of this panel. This is a good place to start, even if you are analyzing an entire force map.
Inspect the Force Curve

- The force curve will be displayed with force on the Y-axis and Indentation on the X-axis.
- Note the crosshair on the graph showing the location of the software’s current estimation of the contact point.
- Also note the software’s first fit to your chosen elastic model, indicated by a brown line. In the example, the first fit does not match the data very well, indicating that we have more work to do before we get a better fit on our data.

6. You can change the selected curve either by going back to the Display tab or by pressing the arrow buttons under the Fit Input grouping on the Elastic Panel. You can also use the keyboard arrow keys to navigate across adjacent curves, see 2.2.3.

Select the Region  The JKR model can fit either Extend, Retract or both (Ext+Ret). The JKR model does not include viscoelastic deformation, so when there is significant separation between extend and retract (as shown in these force plots), you will not end up with a good fit to both extend and retract. The fit curve is between extend and retract, and describing neither. This should be an indicator that your model may be incorrect, and you may want to do a force rate dependency study to see what effects that loading rate has on the shape of the force curves. These curves do however have a very clear decrease in restoring force just before the rupture on retract, this is a signature of the JKR model that is absent in Hertz and DMT. So for the sake of this example, we set the fit input to retract to see how well the JKR model could describe that portion of the curve. You can see it immediately does a much better job of describing that data.

8. Check your warnings: When the fit is made, the software checks for a series of common problems that are found in indentation data. The top-right corner of the panel will display
any problems that have been detected with the data in yellow. Click the name of the warning for a description of the problem. If there are no issues detected, a green button labeled No Problems Detected will be displayed.

9. Input your model assumptions: Next, you will want to assume a tip shape, size and a Poisson ratio for your sample. These need to be entered into the model assumption grouping. The JKR model is derived for a paraboloid shaped tip. The tip material is not required for soft samples, when the sample is in the kPa to a few MPa range, then the difference in a 60 GPa indenter and a 360 GPa indenter is negligible.

   a) In this case, we used an unmodified silicon nitride TR800 PSA (Short) [http://www.asylumresearch.com/Probe/TR800PSA,Olympus], which we assume is a spherical apex with a radius of 20 nm. We also assume a Poisson ratio of 0.5. Note that assumptions are very difficult to make, and in real-life situations it might not be feasible to expect that your assumptions are constant throughout a single data set.

10. Select the fit parameters and adjust your initial guess, if needed. The more fit parameters, the more freedom the fit function has, which makes it easier for it to get lost. If you have a difficult time converging (getting a good fit), try turning off some parameters, and adjusting them by hand. For example, adjust the depth offset, so that it looks correct to you, and turn off that fit parameter. Adjust the pull off force to be the minimum of the curve, and turn off that parm. Adjust the force offset so that the base line looks correct, and turn that parameter off. Then do a fit, and see where that gets you. Once you are close, you can turn on more fit parameters, and they should improve when you fit.

11. Adjust the fit region, if needed: In many cases, only a subset of your curve will be amenable to fitting. By default, the fit is made between 10%-90% of maximum indentation. To select a smaller or larger region, press the Show Fit Region Controls Checkbox. Using the parameters shown, you can select a lower and upper bound by inputting a specific value or just a percentage of either the maximum force or indentation that will be fit by the model. If the low parameter is grayed out, that means that you are either trying to fit the contact point (see the previous step) or your are fitting both extend and retract. In the later case, the upper limit is found in both the extend and retract data, and the force above that level is excluded from the fit.

12. Fit your Data

   • You will see the model fit represented as a brown dashed line on your force curve, and the numbers in the results grouping will be updated. To the right we show a good fit on our data.

13. Look at the results part of the panel. The modulus of the sample is highlighted in yellow. The reduced chi-square ( \( \chi^2 \) ) value is an estimate of the fit quality, where values closer to 1 indicate a better fit. The reduced modulus is the actual measured modulus, which is a convolution of the sample modulus and the indenter modulus.

14. Start Over, if needed: This button removes the region of fit restrictions and allows you to start again.
Select Entire Force Map: Selecting this tab will result in the border of the panel turning green (Figure 2.25c on page 92).

Fit an Entire Force Map: We started by analyzing one force curve in order to adjust our fitting parameters and assumptions. We can now analyze an entire force map. Note that when you do this, you apply the same assumptions and fit parameters to every curve in the force map. This might not be appropriate as the variability of the sample and the tip during the experiment might require different assumptions for different areas.

Check for warnings: The warnings area of the panel should now give you the option to check a small subset of your data for fit problems. It will also list the estimated length of time that such a check will take. The warnings that appear here are identical to those described in the previous section.

Select your data output: using the top left part of the panel, you can select the name of the image output. The AutoName checkbox is selected by default, and will produce an image with the same name as the folder that contains your force map data this name will be listed just under the check box. Be careful if you do not check the box; adding the calculated data as a layer into a new image can be tricky, especially if you are adding it to an image file that has a different pixel count or scan size.

Fit your data: Select the fit button. A progress bar with an estimated time to completion will appear as the program fits the individual curves.

Explore your Data
- A figure with results should appear. Each pixel represents a modulus value.
- To see a point in more detail, simply click the point on the image. The force curve display will show you that force curve and the ‘Results’ area of the Elastic panel will show you the value.

Note Very poorly fit points will be displayed as dark red pixels. If you choose one of the problems noted in the Warnings panel, a bright red mask will indicate which areas represent the reported warnings.

Re-fit a specific point, if needed: If a single point has been fit poorly, or requires different assumptions or parameters, you can select that point and adjust the fit parameters in the Elastic tab, just as you would when analyzing single force curves. If your new parameters and result are satisfactory, you can then update the force map with the new value by selecting the Update value in map with current fit button.
Further Analysis (Optional) It may be possible to distinguish between two different samples by looking at the histogram of the obtained Young's modulus.

22. To show the Histogram tab, make the Analyze Panel by pressing A at the top right of your result map, see 1.3.3.

Further Analysis (Continued)

23. Click on Make new histogram button.

• The resulting histogram can be adjusted using the slider to control the number of samples per bin.

• A Gaussian fit can be applied to the data by selecting Do it on the top right of the Histogram window. You can also fit a subset of the data by bracketing the region of interest with the Igor cursors (press CTRL + i to reveal these) and then doing the fit.

Note In this example, the Gaussian mean value was 1.25 MPa with a standard deviation (Width) of 0.0287 MPa. Compared to the actual average of I don’t know.
3. ARgyle 3D Data Visualization

Chapter Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1</td>
<td>Viewing Saved Images in 3D</td>
<td>98</td>
</tr>
<tr>
<td>3.2</td>
<td>Overlaying Data on a Surface</td>
<td>99</td>
</tr>
<tr>
<td>3.2.1</td>
<td>Basic Examples of Color Overlay</td>
<td>100</td>
</tr>
<tr>
<td>3.2.2</td>
<td>Overlaying Data from Difference Sources</td>
<td>102</td>
</tr>
<tr>
<td>3.2.2.1</td>
<td>Overlay of Height on Height</td>
<td>103</td>
</tr>
<tr>
<td>3.2.2.2</td>
<td>Overlay Tricks</td>
<td>104</td>
</tr>
<tr>
<td>3.2.2.3</td>
<td>Flattened Surface Overlay on Topography</td>
<td>104</td>
</tr>
<tr>
<td>3.2.2.4</td>
<td>Error Signal Overlay on Topography</td>
<td>105</td>
</tr>
<tr>
<td>3.3</td>
<td>Display Settings</td>
<td>105</td>
</tr>
<tr>
<td>3.3.1</td>
<td>Axes, PrefS, Lights, and Windows Tabs</td>
<td>106</td>
</tr>
<tr>
<td>3.3.2</td>
<td>Color Tables, Rotate, Zoom, Pan, and Lighting</td>
<td>107</td>
</tr>
<tr>
<td>3.3.3</td>
<td>Z Axis Range, Offset, and Clipping</td>
<td>111</td>
</tr>
<tr>
<td>3.3.4</td>
<td>3D Graphics Aspect Ratio</td>
<td>113</td>
</tr>
<tr>
<td>3.3.5</td>
<td>Anaglyphs, Auto Rotation, and Fly-Overs</td>
<td>114</td>
</tr>
<tr>
<td>3.4</td>
<td>Exporting Images</td>
<td>115</td>
</tr>
<tr>
<td>3.5</td>
<td>Activating Real Time ARgyle\textsuperscript{\textregistered}</td>
<td>116</td>
</tr>
<tr>
<td>3.6</td>
<td>Advanced Command Line Control</td>
<td>117</td>
</tr>
<tr>
<td>3.7</td>
<td>ARgyle Lite Windows App</td>
<td>117</td>
</tr>
</tbody>
</table>

ARgyle\textsuperscript{\textregistered} (a play on ArGL or Asylum Research Graphics Library) is the MFP-3D’s 3D image rendering software. It uses open GL code and the graphics card on your PC to produce stunning 3D representations of your data. In real-time or with offline analysis, custom colors and specular lighting can bring out features in your data that are not easily perceived in the standard 2D view. It also allows multiple data channels to be overlayed as color on another data channel.

There are two ways to get started using ARgyle\textsuperscript{\textregistered}, depending on whether you are imaging in real time or doing offline analysis. 3D representations of saved data will be covered first, so this tutorial can be used even if you are not actively imaging a sample. For the same capabilities with reference to data being collected real-time, please see Section 3.5 on page 116.

### 3.1. Viewing Saved Images in 3D

1. Open the Image Browser Panel as outlined in Section 1.1 on page 5.
Open a 3D Window:

- Open an image of choice. This will bring up the 2D image display window.
- Select a tab of the image: probably height or, as shown here, Zsensor.
- Click the 3D button.

3. A 3D rendered image will now appear in a new window screen. Figure 3.1 on page 99 shows a typical example. The data is scaled in a box of aspect ratio 3 to 1. The color bar corresponds to the total range of the Z axis.

4. Try a few things with your mouse:
   a) Click-drag on the 3D surface with the left mouse button to rotate the view.
   b) Use the mouse wheel to change the level of zoom. Clicking and dragging the left mouse button while holding down the ‘Ctrl’ key has the same effect.
   c) Right-click-drag to change the angle of the lighting.
   d) ‘Shift’+left click and drag to pan the image within the XY plane.

![Figure 3.1](image_url): Typical ARgyle window when it first opens.

3.2. Overlaying Data on a Surface

Figure 3.2 on page 100 shows an example of an overlay. Unlike the images covered so far, the color map overlay has no relation to the data channel it is overlayed on. In this case the color is proportional to surface potential at the cantilever tip as measured by Kelvin Probe Force Microscopy, but the shading and 3D rendering is proportional to the sample topography. The potential as measured
Ch. 3. ARgyle 3D Data Visualization  Sec. 3.2. Overlaying Data on a Surface

at each pixel is painted over the sample topography. It is not unlike a 3D rendering of a geographical map in which colors represent vegetation type. This effect can be quite useful for depicting many quantities measured by AFM such as magnetic field, conductivity, tip sample capacitance, and cantilever phase.

**Note**

AFM images commonly have spikes in the data, which can be very distracting in surface plots. Use of the filter panel can be a quick and easy way to clean up the image for use as a surface plot. See Section 1.2.5 on page 30 for detailed instructions.

![Surface potential overlay on topography.](image)

**Figure 3.2.:** Surface potential overlay on topography.

3.2.1. Basic Examples of Color Overlay

1. Open the Image Browser Panel as outlined in Section 1.1 on page 5.
2. Open a 2D Window:

- Open an image of choice which brings up the 2D Image Display window. Here we show a polymer topography image and the phase channel. Both are flattened and slightly filtered for noise.

3. Set the Color Channel:

- On the 2D image graph
  - Select the channel you want for the color. This will usually be phase, current, or some other measured quantity.
  - ‘Ctrl’ + Click on the 3D button. This will set the currently displayed layer as the color for the next 3D image.

- OR-

- Open the Master ArGL Panel by selecting AFM Analysis ➔ 3D Surface Plots from the menu bar.
  - Click the New tab.
  - Click the Color checkbox.
  - From the Color pull-down, select the same data file as you selected for the surface.
  - From the Data Type pull-down to the right of it, select the desired channel in that image.
Set the Surface Data:

- On the 2D image graph:
  - Select the channel you want for the surface. This is usually height, Zsensor, or a modified version thereof.
  - Click the 3D button.
- OR-

- From the Master Argyle panel:
  - Click the New tab.
  - Select the topography data file from the Surface pull-down.
  - Select the desired channel of that image from the Data Type pull-down to its right.
  - Click the Do It button to create the 3D view.

- The image shows a nice example of how one value of phase associates with ridges and another value with furrows.

**Note** Once the 3D image is rendered, neither the surface nor the color channel can be reset without closing the window.

### 3.2.2. Overlaying Data from Difference Sources

![Figure 3.3: Force map overlay on LFM image.](image)

The previous section overlaid the phase channel from one image onto the height channel from the same image. As you may have guessed from the pull-down menus when you selected the Surface
and *Color* sources, the channels do not have to be from the same image; surface and color sources can be selected from any open images. Figure Figure 3.3 on page 102 shows an example of a lateral force image which is used as the surface source (topography actually represents force) with a color overlay based on a map of force curves.

The sample is a micro contact printed mercapto undecanoic acid (-COOH terminus), back filled with dodecanethiol (-CH3 terminus). The Au coated SiNx tip had the acid thiol on it as well, and was acquired in a pH 4 buffer standard. The example was done in moderate haste to show this type of experiment can be done, and seems to correlate reasonably well.

### 3.2.2.1. Overlay of Height on Height

An overlay of topography as a color on topography in a 3D image can be very useful when trying to create a certain data landscape. In a standard 3D image, the color bar of the height is directly linked to the range of the Z axis. The only way to get a certain color to occupy a certain altitude in the topography is to translate offset the data, usually causing some of it go outside of the frame box.

By associating color with a secondary channel, the ArGL master panel allows the color scale to be offset freely. Please follow this brief demonstration.

1. Open the Image Browser Panel as outlined in Section 1.1 on page 5.

#### Open a 2D Window:

- Open an image of choice which brings up the 2D Image Display Window.
- Select a tab of the image data channel of interest, probably height or, as shown here, Zsensor.
- ‘Ctrl’ + Click on the 3D button.

#### Open a 3D Window, Topography:

- Go back to the image.
- Click on the 3D button, but do not hold down ‘Ctrl’.
4. Manipulate the Color Bar Scaling and Offset:

- Select the View tab.
- Set View Mode to 'color scale'.
- Use the sliders to change the color scale range and offset. Notice here that the total range on the color scale is 2 microns, while the total range on the z axis is 500 nm. This cannot be achieved in a non-overlay type graph.

3.2.2.2. Overlay Tricks

These are not intended for quantitative scientific visualization, but can be very helpful when trying to communicate features of an image.

3.2.2.3. Flattened Surface Overlay on Topography

You may want to do a 3D rendering of some material that has smaller features but some larger curvature of radius, for instance, large spheres or hair. The problem is that the finer details of the topography features do not get colored well in ARgyle due to the extreme changes in Z scale of the material.

To solve this problem, flatten a height image channel with a second order flatten to take out the large scale curvature of the material, then overlay it onto a Z sensor or copied height channel that has nothing greater than a 0-order flatten applied to it.

Using ARgyle, overlay the 2nd order flattened image onto the other, such that the 2nd order image is the colored layer. This will help to bring out the smaller features much better. Figure 3.4 on page 105 shows an example of this technique. Note that this technique is mostly to enhance visualization. The color bar may best be left off since its scale will only reflect, at best, local variations with respect to the surface of the object.

---

1 This idea courtesy of Scott Maclaren, Center for Microanalysis of Materials, Frederick Seitz Materials Research Laboratory, University of Illinois, Urbana Champaign.
3.2.2.4. Error Signal Overlay on Topography

The amplitude signal in AC mode imaging or the deflection channel in contact mode imaging, also known as the error signal, is a measure of the inability of the Z feedback mechanism to actually keep the cantilever amplitude fixed. When the cantilever encounters edges in the sample, it will take some time for the feedback to react. During this time, the amplitude or deflection will not be at their respective set points. The resulting image of this signal often looks appealing since it accentuates edges and ignores slower variations in topography. It contains no direct topographical information - only convoluted information which, in a way pleasing to the human eye, brings out small surface detail. It is not unlike some of the traditional edge finding filters that can be found in the Filter tab of the Modify Panel.

When imaging cells, users commonly overlay the amplitude signal onto the overall topography to visually enhance the presence of small surface features. Always clearly state how the image was processed, since this borders on “Photoshopping” the actual data.

3.3. Display Settings

When the 3D button is clicked the ArGL Master Panel is also opened along with the 3D representation of the data. This gives additional controls over the 3D image beyond the mouse clicks and drags of the last section. Each of the tabs will be discussed, but out of order for the sake of clarity.
Figure 3.5.: Fibroblast cells on a glass substrate. Overlay of the amplitude image channel on the topography. Some blue colored specular lighting added.

Note

On the first activation of a 3D image, the panel will have certain default parameters (i.e. Zoom, scale, rotation, color, etc.) that may appear off-scale (in Z) if the surface features are large relative to the XY scan area, or close to scale (in Z) if the features are small. If you have already processed a 3D window in the current experiment, the new ARgyle image will have the same rotation, zoom, etc. as the previously opened 3D window. It will have the same Z data scale as the 2D image in the Display Window.

3.3.1. Axes, Prefs, Lights, and Windows Tabs

The tabs that are self-explanatory will be discussed first. Take a look at Figure 3.6 on page 107 and peruse the settings. Within Igor, you can always click the ‘?’ buttons next to any item for more explanation.

Here are some of the more popular actions on these panels, even though many users will rarely use any of them:

Remove text or axes  Go to the Axes tab. Uncheck the ‘Show Axes’ or the ‘Axes Labels’ checkboxes.

Arrange or close multiple 3D image windows  Go to the Windows tab. Hold ‘Shift’ and click on windows in the list to stack, tile, or close them en masse.

Make surfaces appear shiny  Go to the Lights tab, and check ‘Shiny’. The percentage next to the ‘Shiny’ checkbox will adjust the intensity of specularly reflected light. Apply changes to the last viewed image or check ‘All’ to apply to all current and future 3D windows.
Change illumination color  Go to the Lights tab, and change the light color using the Color drop-box. This only affects the specularly reflected light, so if ‘Shiny’ is set to 0%, then the light color is irrelevant.

Change the background color  Go to the Prefs tab. Use the Color dropbox to change the background.

Note  Apply changes to the last viewed image or check ‘All’ to apply the changes to all current and future 3D windows.

3.3.2. Color Tables, Rotate, Zoom, Pan, and Lighting

Starting Point:

1. We will apply a series of actions to the image on the right.

   This instruction set will show the relevant panel, usually the View tab with different modes selected, on the left and the result will be on the right, with instructions below.
2. Choose a Different Color Table:
   - Select the Display tab.
   - Select a different color table using the Color Map dropbox.
   - Invert the direction of the color table with the Invert checkbox.

   Optional (Not Show in the Image Above)
   - Use the ‘Negative Color’ checkbox to cause the image to be a color negative of the initial color scale. Red, for instance, would be displayed as green.
   - Remove the color scale bar from the right of the image by unchecking ‘Color Bar’.

3. Rotate the Image:
   - Under the View tab, select ‘Rotate’ mode from the View Mode pull down.
   - Change the view angle using the text fields or the sliders.
   - Notice that the colors associated with the pitch and rotation fields are also applied to the sliders.

   Optional
   - Or with the mouse, left click-drag on the 3D image to change the rotation variables.
4. **Zoom In:**
   - Select the **View** tab.
   - Set **View Mode** to ‘Zoom’.
   - Enter a number in the **Zoom Factor** field, or slide the left slider back and forth.

   **Optional**
   - Or with the 3D image window selected, rotate the mouse wheel to zoom in and out.

5. **Translate the Image:**
   - Select the **View** tab.
   - Set **View Mode** to ‘Offset’.
   - Enter XY offset values or move the sliders to slide the image around on the screen.

   **Optional**
   - Or left Shift-click to translate the 3D image.
6. Change the Lighting Angle:
   - Select the View tab.
   - Set View Mode to ‘Light Rotate’.
   - Enter values or use the sliders to change the incident angle of the image lighting.

Optional
   - Or right-click-drag the mouse pointer over the 3D image.
3.3.3. Z Axis Range, Offset, and Clipping

1. Change the Z Axis Range:
   - Select the View tab.
   - Set View Mode to 'Data Scale'.
   - Clip must be set to 'None'.
   - Enter a new value into the Data Scale field. In our example we cut the data scale in half, increasing of the size of the 3D topography by a factor of 2.
   - Alternatively, you can use the yellow left slider.

Note: Since the color scale is normally fixed to the vertical range, the colors of the surface which extend above the box stay constant. The only reason the surface still looks like data is due to the shadows cast by the lighting. If you go to the Master ArGL Panel and turn off the lights under the Lights tab, then the out of range parts of the image will become featureless.

Note: The data expands equally up and down from the vertical midpoint of the Z range.

Note: The extremes of the data scale can give visually confusing results, or may even seem to erase the data. If the data seems irrevocably distorted, the Fix button will restore the default settings.
2. Clip Data Extending Outside the Frame:
   - Select the View tab.
   - Set View Mode to 'Data Scale'.
   - Set the Clip pull-down menu to 'Clamp'. The data extending beyond the vertical range are capped with solid surfaces.
   - To leave an open hole in which you can see the backside of the data, select the 'Clip' option from the pull down menu.

3. Change the Z Axis Offset:
   - Select the View tab.
   - Set View Mode to 'Data Scale'.
   - The Clip menu can still be set to 'Clamp'.
   - Enter a new value into the Data Offset field. In our example, we offset by 125 nm, which brought the taller features nearly back inside the box, but moved lower features outside the box.
   - Alternatively, use the blue right slider to adjust the offset value.
3.3.4. 3D Graphics Aspect Ratio

Change the 3D Graph Aspect Ratio:

- Select the View tab.
- Set View Mode to ‘Zoom’.
- Change the Z Scale from the default value of 0.33 to 0.66. The result is a stretched graph which resembles the one in Step 1 on page 111. In this case however, the entire box is taller and the data still fits inside that box. The data will not be clipped and will not exceed the color scale.
- Alternatively, you may move the rightmost, blue slider to change the value.
Ch. 3. ARgyle 3D Data Visualization

Sec. 3.3. Display Settings

2. 3D Graph Aspect Ratio 1:

- Select the View tab.
- Set View Mode to ‘Zoom’.
- Click the Aspect 1 checkbox.
- The Z Scale value will assume a value which shows the sample in its true proportions. For many AFM samples which have tens of nanometers of topography over a many micron scan range, it will appear almost flat. In our case, the sample is fairly rough and still gives something to look at.
- Changing the Zscale by entering a number or using the slider will automatically undo Aspect 1.

Note. Aspect 1 only works when the Z axis has units of length. While not common, any quantity, such as phase or amplitude, can be plotted on the Z axis. In this case the checkbox has no effect.

Note. The term Aspect Ratio 1 refers to the actual sample X, Y, and Z dimensions, not to the way the frame looks on the screen. This is not to be confused with setting the Zscale to 1, which always makes the 3D frame appear to be a cube.

3.3.5. Anaglyphs, Auto Rotation, and Fly-Overs.

Viewing with 3D Glasses:

- Go to the Display tab.
- Click the Anaglyph button.

Note. While guaranteed to work on all computers shipped with Asylum AFMs, the Anaglyphs may not always work with unusual graphics processors. This is often the case with laptop computers.

Note. 3D viewing is most effective with a gray scale color table, as shown in this example image.
3.4. Exporting Images

The are many ways to export images from the ARgyle window.

**Cut and Paste a Screen Shot:**

1. Make the 3D image window the forward most image.
2. From the menu bar select *Edit* ➔ *Copy*. This puts a screen shot of that window on the clipboard.
3. Open another program where you can paste this bitmap, such as Paint, Photoshop, or e-mail.
4. From the menu bar of that program, choose *Edit* ➔ *Paste*.

**Note** Since this is a screen shot, the larger you make the window on screen, the higher your exported image resolution.

**Save a Screen Shot to Disk:**

1. Make the 3D image window the forward most image.
2. From the menu bar select *Edit* ➔ *Export Graphics*.
3. Select the file name, location, and type.
4. Click *Save* to export the screen shot to disk.

**Note** Since this is a screen shot, the larger you make the window on screen, the higher your exported image resolution.
3.5. Activating Real Time ARgyle™

The lighting and shading features of ARgyle can be useful when fine tuning imaging parameters. It is possible to update a live 3D image, line by line, as data is being collected. ARgyle does not distinguish between real time images and saved images; all of the manipulations discussed in this chapter can be applied to either.

1. Start imaging.

Export to Layout:

- Make the 3D image window the forward most image.
- Select the New tab of the Master ArGL panel.
- Click the Export to Layout button. To learn more about this, see Section 1.4.4 on page 57.

Note This will only work for open 3D windows. All the pull-down menus above the Export to Layout button have no bearing on this feature.

-OR-

4. Save a High Resolution Bitmap to Disk:

- Make the 3D image window the forward most image.
- Go to the Igor Command line (‘Ctrl’+’J’).
- Type
  \[ \text{argl}\_\text{export2}("", ",", 0, 1, 3000, 2000) \]
  followed by the return key for an exported image of 3000 pixels wide by 2000 pixels tall.
  The pixel values have a 4000 maximum.
- From the dialog box that comes up, select the file name, location, and type. In this case, the type should be a bitmap (BMP).
- Click Save to export the graphic.

Note If you have the color bar showing and choose a narrow window, the color bar will fall atop your 3D graphic. Choose an aspect ratio similar to the screen. The command line approach will only see which 3D window is currently on top, not how it is proportioned.
Open a 3D Window, Topography:

- Open the Master ArGL Panel by selecting from the menu bar AFM Analysis \(\triangleright\) 3D Surface Plots. Select the New tab.
- From the Surface pull-down menu, select ‘Realtime’.
- From the Data Type pull-down menu to the right, select the desired channel, usually ‘Height’ or ‘Zsensor’.
- Either skip to the next step or, IF you want color overlays, click the ‘Color’ checkbox and select Realtime as the source. For Data Type, the usual channel is Phase, but any other channel of your choice may be selected.
- Click the ‘Do It’ button.

You will now have a 3D image on screen which fills up line by line. You can apply any manipulations described in this chapter.

3.6. Advanced Command Line Control

ARgyle has advanced command line features which will eventually be incorporated in the Igor GUI interface. If you are curious, please read the following online help file:

From within the AR SPM software, select from the menu bar:

*Help \(\triangleright\) AR Help Files \(\triangleright\) Xop Help Files \(\triangleright\) ARgyle help*

3.7. ARgyle Lite: Stand Alone Data Visualizer for Windows

Asylum Research has released a free program which incorporates all the functionality of ARgyle 3D image viewing. See Figure 3.7 on page 118 for a screen shot of the application. It can be downloaded from [https://support.asylumresearch.com/forum/content.php?157-ARgyle-Light](https://support.asylumresearch.com/forum/content.php?157-ARgyle-Light).

This program is an excellent way to share and view Asylum Research SPM data on computers which do not have the Igor Pro / AR SPM software installed. You can send *.ibw files to anyone if they install the free viewer.

For true 3D visualization, please contact Asylum Research for a free pair of 3D glasses: sales@AsylumResearch.com.

If you understand the ARgyle functionality described in this chapter, you will find the ARgyle Lite user interface quite familiar. The only limitation is that the software works with only one image.
(.ibw) file at a time, so it is not possible to overlay data from one image onto another, as in the force map example in Figure 3.3 on page 102.

**Figure 3.7.:** ARgyle Lite windows application.
Part II

Programming

Part II: Who is it for? The AR SPM software can be customized for your needs in a variety of ways. Custom control panels and macros can be set up with no programming needed. But if you want even more control you can write your own Igor code. This section will cover the basics of writing Igor code to control the AFM.
Part Contents

4 Basic Programming Tutorial ........................................ 122
  4.1 Introduction .................................................... 122
  4.2 Conventions ..................................................... 122
  4.3 Help .......................................................... 123
  4.4 Low Level Parameter Names ................................. 123
  4.5 High Level Parameter Names ............................... 124
  4.6 The Crosspoint Switch ....................................... 125
  4.7 Parameter Control and Collection ......................... 127
  4.8 Drive the XY Stage in a Circle ............................. 131
  4.9 Feedback Loops ............................................... 132
  4.10 Setting Up Your Own Z Feedback Loop ................... 133
  4.11 Creating Your Own Programs ............................... 135
  4.12 More Programming Resources .............................. 136
4. Basic Programming Tutorial

The purpose of this tutorial is to give you a start on learning how to control the AFM at a low level using Igor. You might want to do this to make the AFM do things not available in the graphical user interface of the software. Before running through this tutorial you should be very comfortable using the AFM and, ideally, have practiced a little bit of Igor programming. At the very least, it is important to understand the difference between a wave’s scaling and wave indexes and doing waveform assignments from the command line. The "Getting Started" tutorial that is part of the Igor manual will teach you this much. This tutorial will focus on commands specific to the Asylum AFMs. At the end of this tutorial we’ll discuss some references for more programming commands.

4.2. Conventions

Anytime in this tutorial where you see something indented and in a different font, such as

print td_ReadValue("Head.Temperature")
it is meant to be executed from the Igor command line. You can just copy and paste them, but you will learn more quickly if you type them out yourself. The value that the function returns to the Igor history will often be shown below the command, e.g.

```
print td_ReadValue("Head.Temperature")
31.625
```

This is just to show you what you might expect to see. You shouldn’t enter the 31.625 into the command line.

### 4.3. Help

The majority of commands you will be learning about are commands that start with \texttt{td\_}. The \texttt{td} stands for 3D and/or Todd Day, the programmer that created the commands. Help for these commands can be found in the Xop Help file. The easiest way to get to this is to go to the menu \textbf{Help $\triangleright$ Command Help}. This brings up the Help Browser and you can just scroll down to get help on the command you are interested in learning about. Make sure the Functions, Operations, and Programming check boxes are checked.

Another very useful help item is that if you type the command into the command line and right click on it you can go to the help for that command or insert a template. Inserting a template is very useful if a command takes several parameters and you don’t remember the order.

### 4.4. Low Level Parameter Names

Everything on the instrument that has a value you might want to read or control has a parameter name. These parameter names are constructed as Device.[Group(s).]Parameter. For example, to read the value of a thermometer that is built into the MFP-3D head, you would execute

```
print td_ReadValue("Head.Temperature")
31.625
```

The "head" refers to a specific device that is part of the instrument, while the the "temperature" is a specific parameter that the head owns. Some examples of devices are the head, scanner, and ARC. Additional devices such as heaters can also be added to the instrument. You can see all the devices hooked up to the instrument by clicking on the gear icon at the bottom left-hand side of the screen.

Since many devices have a lot of parameter names, there is an additional level of organization called groups. For example the ARC has a lot of analog-to-digital converters (ADC’s) and digital-to-analog converters (DAC’s) in it. There is a group named "Input" that contains the ADC’s and a group named "Output" that owns the DAC’s. Furthermore, the controller device is often omitted from the address, as it is the default device to read from. So, for example, to read the value of the X sensor, you would execute

```
print td_ReadValue("Input.X")
-6.84063
```

Similarly,
would apply 60 volts to the X piezo. Note that when you use commands like `td_WriteValue` where you don’t expect an output, you should still precede them by a print command. They will return 0 if everything worked and a non-zero error code if it didn’t. So, for example, if you misspell something you will probably see a 3 or 5 returned.

Note that some outputs can also be read as inputs. You might be interested in knowing what the current voltage to the X piezo is before you change it. So

```
print td_ReadValue("Output.X")
60
```

Another way to access these parameters is to use the menu that pops up when you click on the gear icon at the bottom left-hand side of the screen. A popup menu with icons of the devices currently hooked up will appear. For example, to see the changes you just made, float the cursor over the icon of the ARC in the menu and an additional popup menu will appear. Float the cursor over parameters menu and yet another popup menu will appear with a list of all the devices owned by the ARC. Select `Output` and a panel will pop up that contains all the parameters in the output group. Click on the ‘read’ button and you should see that the X output has a value of 60 V.

Before you start, the High Voltage Relays must be checked to see if they are open or closed. Click on the ARC icon in the toolbar and navigate to `ARC ▶ Parameters ▶ Default`. Then use the read and write buttons to look at and set the state of the `HighVoltageXYRelay` and `HighVoltageZRelay`. You can also change the state of the relays at the command link

```
print td_WriteValue("HighVoltageXYRelay",1)
0
OR
print td_WriteString("HighVoltageXYRelay","Closed")
0
```

At the top of the MFP3D Help file there is a complete list of parameter names as well as the error codes.

### 4.5. High Level Parameter Names

There are also parameters that exist in Igor rather than down at the device level. If you click on the `Programming menu ▶ Global Variables ▶ Master` you will see a table full of parameters and descriptions of what they control. For example, the top item is the `ScanSize` and shows the scan size in meters under the value column.

While you can read these values from the table, while programming it is useful to access them with the `GV (Get Value)` routine. Executing

```
print GV("ZPiezoSens")
```

will print the sensitivity of the Z piezo (in meters per volt) into the history. See Table 4.1 for a list of other get functions.
4.6. The Crosspoint Switch

To make the instrument a lot more flexible, the controller has something called a crosspoint switch inside of it. The crosspoint switch is a lot like an old telephone patch board. It has 16 inputs and 16 outputs and you can connect virtual wires between any of the inputs and any of the outputs. You can have multiple wires running from one input to many outputs.

The crosspoint switch can make programming a bit more complicated because a given ADC isn’t always connected to the same things. From the main menu bar select Programming ▶ Crosspoint Panel to bring up a panel which allows you to see and control the wiring of the crosspoint switch. Switch between contact mode and ac mode and see how some of the signals are rerouted.
When programming you may find yourself using the BNCs on the front of the controller. These appear on the crosspoint switch inputs and outputs. To help keep you sane, we named all the extra ADCs and DACs with letters (e.g. InA) and the physical BNCs with numbers. So, for example, you can connect the BNC In0 to the ADC InA using the top drop down menu in the Crosspoint Panel, and then clicking the Write Crosspoint button.


Probably the most confusing option on the crosspoint is the FilterIn. By routing a signal to FilterIn, you are routing it into a low pass filter of about 36 kHz. The filter signal then reappears as an input to the crosspoint switch named FilterOut. This filter is useful for filtering high bandwidth signals (e.g. Defl) before passing them to a 50 kHz ADC like InA.

A Simple Example with /D8/CS and /D8/CS/CA/CT/CP/CS/CE/CP/D0/D9/CT

You can use the td commands to move the X stage around and measure its motion with the X...
sensor. The stage is approximately centered at 70 volts. If you execute the following commands in a row you should see output similar to those listed here.

```python
print td_WriteValue("Output.X", 60)
0
print td_ReadValue("Input.X")
-0.0396402
print td_WriteValue("Output.X", 70)
0
print td_ReadValue("Input.X")
-0.698834
print td_WriteValue("Output.X", 80)
0
print td_ReadValue("Input.X")
1.51577
```

You just drove the X stage to 60, then 70, then 80 volts. As you can see, the sensor voltage measured this movement and returned three different values. To see what happened in meters instead of volts we can use the sensitivities to convert the voltages.

```python
print GV("XPiezoSens")*20
1.07474e-05
```

This means moving the stage from 60 to 80 volts (20 volt change) should have produced about 9.6 microns of movement. In reality, the sensors measured

```python
print (1.51577 - -0.0396402)*GV("XLVDTSens")
1.1625e-05
```

This is about 11.6 µm. The fact that the stage moved more than we expected is the reason we have the sensors. How far the stage movement is off is dependent on scan size. Try the above experiment for a 2 volt change (drive X to 69 volts and then 71 volts) and you should get better agreement.

While you could make the sample move around by stringing together a lot of `td_WriteValue` commands, that is tedious. A better way is to use an Igor wave to control the stage and collect data. You’ll do this next.

### 4.7. Parameter Control and Collection

It is good practice before sending instructions to the ARC to stop current instructions. The `td_stop()` command does this but in general should not be used as it stops all outwaves, inwaves, and feedback loops.

For now though lets just use the `td_stop` command.

```python
print td_stop()
```

Now make two Igor waves, one to store voltages to drive the X stage and and one to store the sensor values we read.
Ch. 4. Basic Programming Tutorial  Sec. 4.7. Parameter Control and Collection

Make/N=1024 PiezoVoltage SensorVoltage
Next make a graph of each
Display PiezoVoltage
Display SensorVoltage

Move the graphs so you can see both of them. You’ll notice that right now, the wave scaling of both is just p scaling. The X axis on each wave is from 0 to 1023. To use this wave to drive the piezo voltage, it will be much more convenient to have the x scaling in time. While you could set it by hand the easiest way is to use a $t_d$ command. To set up an output wave you will use the $t_d_xSetOutWave$ command. You can find the detailed help for the command as described in Section 4.3 on page 123.

The syntax of the command is

$$td_xSetOutWave(\text{whichBank}, \text{eventString}, \text{channelString}, \text{wave}, \text{interpolation})$$

The parameters are:

- **whichBank** determines which memory bank in the DSP the wave will be stored in. There are three banks of memory, labeled 0, 1, and 2, and each can hold up to two pairs of waves. These waves can be up to 87,380 points long and must be single-precision (32 bit) floating point.

- **eventString** determines when the data will be output. You can think of them as a trigger. You usually don’t want the wave to be output as soon as it reaches the DSP because you might want to synchronize the output with some data collection. The events are group of parameters owned by the controller, so a typical eventString would be "Event.0", but for functions that have a specific event argument, it is simply “0”, the “event.” can be dropped. When we later change the value of this event parameter, the wave will be output to the DAC that drives the X voltage.

- **channelString** is simply a low level parameter name like we learned about. In this case it will be "Output.X".

- **wave** is simply the name of the Igor wave with the data to be sent. Here it is PiezoVoltage.

- **interpolation** determines how quickly the wave will be output. The DAC’s and ADC’s on the ARC all run at 50 kHz, so an interpolation of 1 means that each point in the Igor wave will correspond to a 50 kHz sample. For the 1024 point waves you made, this means the entire wave would be output in about 20 milliseconds. This is very fast, so we will choose an interpolation factor of 100 to give us about a 2 second output.

| Note | Older versions of the AR SPM software (prior to version 101010) ran the ADCs at 100kHz. In that case the output of the above example will take only 1 second. |

Before we send the wave to the ARC we need to populate it with values. Currently each point is set to zero. In this case lets make a ramp over the full range of the piezo (-10V to 150V).

$$\text{PiezoVoltage}[0,511] = -10 + 160*p/511$$
$$\text{PiezoVoltage}[512,1023] = 150 - 160*(p-511)/511$$

Putting this all together gives

```plaintext
print td_xSetOutWave(0, "0", "Output.X", PiezoVoltage, 100)
```

0
If you did everything right you should have gotten a zero in the history.

If you look at the graph of PiezoVoltage that you made, you will notice that the x scale has been updated to reflect the time that the wave will take to output. Shown in (Figure 4.2 on page 129).

![Figure 4.2: Piezo Voltage vs Time](image)

Now you need to set up the SensorVoltage wave to record data. The syntax of the command is fairly similar to that of `td_xSetOutWave`:

```
```

The first four parameters are conceptually identical except `channelString` will now be an input instead of an output.

We also have a callback parameter and decimation instead of interpolation. Decimation is the opposite of interpolation. Rather than creating points we want the DSP to reduce the number of points coming back. Sometimes getting data at 50 kHz is a bit like drinking from a fire hose and you want less information.

The callback function is an Igor function that will be called when the input data has been collected. This is useful so that control returns to Igor while the data is being collected (otherwise Igor would freeze during data collection). This function might be something that does some analysis on the data.

To show how the callback works let's make a very simple example that prints "Done" when the callback hits. To do this we must write some code not in the command line. Select the Windows Menu > New > Procedure. Leave the name as is and hit the New button.

Type in the following onto the procedure window

```
Function InWaveCallback()
    print "Done"
End
```
Now when the callback function hits it should print “Done” to the command line.

One major conceptual difference here is that rather than the data being stored on the DSP like the output data, it is continually streamed back to the PC. This means the banks correspond to "pipes" on the USB connection rather than memory. There are 3 banks, each bank brings back 1 or 2 channels of 24 bit data.

Putting all this together gives

```python
print td_xSetInWave(0, "0", "Input.X", SensorVoltage, "InWaveCallBack", 100)
```

You will see that the x scaling on the SensorVoltage graph has now changed to seconds. You have now set up everything and all you have to do is trigger Event.0. For this it is easier to use `td_WriteString` instead of `td_WriteValue`. They are identical except the first is used for passing strings instead of numbers.

```python
print td_WriteString("Event.0", "once")
```

If all went well, after about a second you should see the SensorVoltage wave get updated with data, and “Done” printed in the command window. The curvature shows that the piezo isn’t moving linearly. If the graph shows noise then the high voltage relays are in the open state, so the voltage is not getting to the piezos. You can check this by clicking on the 'Controller Icon' button of the Igor window and navigating to `ARC ▶ Parameters ▶ Default`. Then use the read and write buttons to look at and set the state of the `HighVoltageXYRelay` and `HighVoltageZRelay`. You can also change this at the command line:

```python
print td_WriteValue("HighVoltageXYRelay",1)
print td_WriteValue("HighVoltageZRelay",1)
```

If you graph the SensorVoltage versus the PiezoVoltage you will see the hysteresis loop the stage traced out (Figure 4.3 on page 130).

![Graph](image-url)

(a) Sensor Voltage vs Time

(b) Sensor vs Piezo Voltage

**Figure 4.3.**
4.8. Drive the XY Stage in a Circle

The set of commands below will drive the XY stage with voltages corresponding to a circle almost full scale for the stage. The sensors will measure what really happened. The example uses \texttt{td\_xSetInWavePair} and \texttt{td\_xSetOutWavePair} which are very similar to the commands you learned above. You can watch the sample movement using the optics of your microscope.

\begin{verbatim}
make/N=(1024)/0 XVoltage YVoltage XSensor YSensor
display XVoltage; appendtograph/R YVoltage
display XSensor; appendtograph/R YSensor
print td\_xSetOutWavePair(0, "0,0", "Output.X", XVoltage,
  "Output.Y", YVoltage,100)
  //0
XVoltage = 70 + 70*cos(2*pi*x/1.024) //X is seconds, 1.024 is the time per cycle
YVoltage = 70 + 70*sin(2*pi*x/1.024)
print td\_xSetOutWavePair(0, "0,0", "Output.X", XVoltage,
  "Output.Y", YVoltage,100)
  //0
print td\_xSetInWavePair(0, "0,0", "Input.X", XSensor,
  "Input.Y", YSensor, ",", 100)
  //0
print td\_WriteString("Event.0", "once")
  //0
print td\_WriteString("Event.0", "once")
  //0
display YSensor vs XSensor
ModifyGraph width={Plan,1,bottom,left}
\end{verbatim}

![Graph](image)

\textbf{Figure 4.4.}

As you can see by Figure 4.4 on page 131, because of piezo non-linearities and hysteresis, the circle isn’t very round.
4.9. Feedback Loops

Note this section is very advanced and you run the risk of damaging your microscope sensors if using unstable gains.

For a lot of stuff that you might want to do (for example, to make a round circle), you will want to use a feedback loop of some sort. The controller is able to run six PIDS loops. These loops have

- Proportional gain $P$
- Integral gain $I$
- Differential Gain $D$
- Double-integral gain $S$

Each parameter belonging to the loop can be accessed; for example, PIDSLoop.0.IGain is the name for the Integral gain of loop 0.

One problem with feedback loops is that if you pick the wrong gains, the feedback loop can oscillate. Besides being incredibly loud, this can also push the sensors out of alignment.

The easiest thing to do is to look at the values that the software uses. Be careful not to look at the gains in the panels themselves (like integral gain on the Main panel or the X and Y gains on the XY gains panel). These are scaled to make it more convenient for users to think about.

To peek at the value that the software uses for Z in contact mode, hit Engage on the meter panel. It doesn’t matter if you have a cantilever in or not. This turns on the Z feedback loop. The following commands will then read the three gain values. This result is typical for contact mode.

```plaintext
print td_ReadValue("PIDSLoop.2.PGain")
0
print td_ReadValue("PIDSLoop.2.Igain")
1000
print td_ReadValue("PIDSLoop.2.SGain")
0
```

It is easiest to look at their values in the PIDS Loop Panel, go to Programming ▶ XOP Tables ▶ PIDS Loop Panel.

For AC mode, the gain will be the opposite sign and smaller.

Similarly, to see the X and Y gains, click "Do Scan" and look at the PIDS Loop Panel, or you could execute the following:

```plaintext
print td_ReadValue("PIDSLoop.0.PGain")
0
print td_ReadValue("PIDSLoop.0.IGain")
6887.8
print td_ReadValue("PIDSLoop.0.SGain")
1075803
print td_ReadValue("PIDSLoop.1.PGain")
0
print td_ReadValue("PIDSLoop.1.IGain")
6357.8
```
In almost all software versions, the X loop is on the first PISLoop (PISLoop.0), the Y is on the second (PISLoop.1) and Z is on the third (PISLoop.2). There is a small chance that the X and Y are on PISLoop.3 and PISLoop.4. You would see this if you went to read the gains.

To set up a feedback loop you will use the \texttt{ir\_SetPISLoop} command, this is because the PID-SLoop panel is automatically updated by the AFM software and does not allow manual overwrite. The syntax of the \texttt{ir\_SetPISLoop} command is

\begin{verbatim}
    ir\_SetPISLoop(whichLoop, eventString, inChannelString, setpoint, pgain, igain, sgain, outChannelString,OutputMin,OutputMax)
\end{verbatim}

The parameters are

- \texttt{whichLoop} determines which of the six feedback loops you will use. They all run at 50 kHz.
- \texttt{eventString} is just like the events described above. Unlike with input and output waves, with feedback loops you often want them to start running immediately. Passing a string of "Always" for the eventString will make this happen for the start string; there also needs to be a comma and a string for the stop event, in our examples "Never".
- \texttt{inChannelString} is the channel string for the input to the feedback loop. For example, in contact mode, this is one of the ADCs (InFast usually), which is wired up to Defl.
- \texttt{setpoint, pgain, igain, sgain} are the setpoint and gains for the loop. After the loop is set up, the setpoint can be driven by a wave. This would be used, for example, to move the XY stage around under feedback control. Note the gains are scaled to be mathematically right. A pgain of 1 will give you a 1 volt output for a 1 volt input. Similarly, the same 1 volt input with an igain of 1 will give you a ramp from 0 to 1 in one second.
- \texttt{outChannelString} is the output of the feedback loop. For contact mode, this would be the Z DAC.
- \texttt{OutputMin OutputMax} are the range of values used for the OutputChannel.

4.10. Setting Up Your Own Z Feedback Loop

So, to set up your own feedback loop in Z, first turn on the meter and make sure you have a deflection close to zero. Also make sure the cantilever is close to the surface by doing an engage the normal way and then withdrawing. Above, you saw that for contact mode, typical gains are P=0, I=1000, and S=0. First you will hook up the Defl channel to the InA ADC by executing

\begin{verbatim}
    print td\_WriteString("Crosspoint.InA","Defl")
    0
\end{verbatim}

Next you will set up the feedback loop with

\begin{verbatim}
    print ir\_SetPISLoop(2,"Always,Never","Input.A",1,0,1000,0, "Output.Z",-10,150)
    0
\end{verbatim}

If all went well, you should see on the meter that the Zvoltage went to a stable value and that the deflection is at 1 volt.
Fig Closed Loop Circle We need to figure out what the gains are for X, Y, and Z. This is done with the same read value commands as above. The microscope should be engaged and scanning.

td_RV is a shorthand function that calls td_ReadValue.

```plaintext
variable/G X_PGain, X_IGain, X_SGain, Y_PGain, Y_IGain, Y_SGain,
    Z_PGain, Z_IGain, Z_SGain
X_PGain = td_RV("PIDSLoop.0.PGain")
X_IGain = td_RV("PIDSLoop.0.IGain")
X_SGain = td_RV("PIDSLoop.0.SGain")
Y_PGain = td_RV("PIDSLoop.1.PGain")
Y_IGain = td_RV("PIDSLoop.1.IGain")
Y_SGain = td_RV("PIDSLoop.1.SGain")
Z_PGain = td_RV("PIDSLoop.2.PGain")
Z_IGain = td_RV("PIDSLoop.2.IGain")
Z_SGain = td_RV("PIDSLoop.2.SGain")

printf "X Gains: P:%.4g I:%.4g S:%.4g\r", X_PGain, X_IGain, X_SGain
printf "Y Gains: P:%.4g I:%.4g S:%.4g\r", Y_PGain, Y_IGain, Y_SGain
printf "Z Gains: P:%.4g I:%.4g S:%.4g\r", Z_PGain, Z_IGain, Z_SGain
```

Now let’s make a variable Radius (the size of the Radius circle in volts). The range of the sensor is between -10V and +10V but they don’t use the full range. Try using 3V for a radius.

```plaintext
variable Radius
Radius=3
```

We then need to make all the waves.

```plaintext
Make/N=(1024)/0 XVoltage YVoltage XSensor YSensor XCommand YCommand
Display/K=1 /W=(5.25,41.75,399.75,250.25) XVoltage
Appendto график/R YVoltage
Display/K=1 /W=(7.5,275.75,402,484.25) XSensor
Appendto график/R YSensor
Display/K=1 /W=(409.5,41.75,662.25,250.25) YSensor vs XSensor
ModifyGraph width={Plan,1, bottom, left}
```

Now setup the circle commands.

```plaintext
XCommand = Radius*cos(2*pi*p/1024)
YCommand = Radius*sin(2*pi*p/1024)
```

We should do a td_stop() to make sure nothing else is running.

```plaintext
print td_stop()
0
```

We now set up the feedback loops for X and Y. Notice how the initial setpoint is set to the Radius for X and 0 for Y. This is because the XCommand starts at a voltage equal to the Radius and the YCommand starts at 0V.

```plaintext
print ir_SetPISLoop(0,"Always, Never","Input.X",Radius,X_PGain, X_IGain,
We then pass the feedback loop voltages that we would like using a command signal and it will vary the XVoltage and YVoltage to try to achieve this. We will use the trick to look at outputs (Output.X) as inputs to see what the voltages are and similarly we display the input voltages.

![Graphs showing X, Y Voltage vs. Time and Y Sensor vs. X Sensor](image)

**Figure 4.5.**

As you can see in Figure 4.5 on page 135, the circle should be perfectly round.

### 4.11. Creating Your Own Programs

While all the examples here have been done from the command line except the callback function it is pretty easy to start copying and pasting commands to make your own functions. Inside procedure windows.

```python
X_SGain,"Output.X",-10,150)
0
print ir_SetPISLoop(1,"Always,Never","Input.Y",0,Y_PGain, Y_IGain, Y_SGain,"Output.Y",-10,150)
0

print yd_xSetOutWavePair(0, "0,0", "PIDSLoop.0.Setpoint", XCommand, 0)
0
print yd_xSetInWavePair(0, "0,0", "Output.X", XVoltage, "Output.Y", YVoltage, ",", 100)
0
print yd_xSetInWavePair(1, "0,0", "Input.X", XSensor, "Input.Y", YSensor, ",", 100)
0
```

As you can see in Figure 4.5 on page 135, the circle should be perfectly round.
4.12. More Programming Resources

4.12.1. Manuals

The AR SPM software is written in a third party software environment called IGOR. There is a pdf of the igor manual in `<Igor Pro Folder>\Manual\IgorMan.pdf`, where `<Igor pro Folder>` is the location where igor is installed. The manual starts with the all important “Getting started” guide. Igor is supplied by Wavemetrics, and they have an excellent website (http://www.wavemetrics.com) with additional information like a knowledge base and a user forum.

4.12.2. Help Files

All of the AFM related user interface panels were programmed by Asylum Research programmers using the tools available in the IGOR environment. To make that easier, many special functions are written which are subroutines based on IGOR commands. An up-to-date list of these Asylum Research functions can be found in the AR SPM software in the main menu bar under Help ⊲ AR Help Files ⊲ AR Common Functions. Note that all these functions are stored in files which you can open, and copy from to make your own custom code and user panels. One might want to explore the higher level macro programming capabilities, but in the end you are allowed to delve into the source code of nearly every aspect of the AR SPM Software.

In the same area there are other useful help files with respect to programming under Help ⊲ AR Help Files ⊲ AR Advanced.

Finally there are a list of low level commands which are mainly related to communicating with the Asylum Research hardware. You have already seen some of them in this tutorial (the ones starting with td_). These commands supplement the ones supplied by IGOR. An up to date list can always be found at: Help ⊲ AR Help Files ⊲ XOP Help Files ⊲ MFP3D XOP Help. The MFP3D reference is historical and the files also cover more recent instruments such as the Cypher AFM.

4.12.3. User Forums

Years of Asylum Research SPM Discussion are archived at support.asylumreseach.com. Once you join you can peruse the DIY programming section of the forums or post questions. All Asylum Employees are forum members and within a day you will typically get an answer from the experts at Asylum, but also from other power users around the world. The support site also hosts the latest manuals and software updates for your instrument.

4.12.4. Give us a call

Always feel free to contact us directly at Support@AsylumResearch.com

or by calling us if you need some more help.